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TUYÊN BỐ BẢN QUYỀN 

 

 

Tài liệu này thuộc loại sách giáo trình, nên các nguồn thông tin có thể được 

phép dùng nguyên bản hoặc trích dùng cho các mục đích về đào tạo và tham khảo. 

Mọi mục đích khác mang tính lệch lạc hoặc sử dụng với mục đích kinh doanh 

thiếu lành mạnh sẽ bị nghiêm cấm. 
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LỜI GIỚI THIỆU 

 

Giáo trình “Xây dựng bài giảng e-Learning” được nhóm tác giả biên soạn 

trên cơ sở thực tiễn phát triển e-Learning hiện nay, nội dung bài giảng được xâu 

chuỗi theo logic mạch kiến thức, từ lý thuyết đến thực hành, từ việc giới thiệu tổng 

quát đến chi tiết, kiến thức lý thuyết được trình bày theo từng bước hướng dẫn, 

thực hành với yêu cầu, đầu ra sản phẩm cụ thể, phần mềm cũng được nhóm tác giả 

cân nhắc lựa chọn để đáp ứng tốt nhất yêu cầu, chuẩn của một bài giảng  

e-Learning, phù hợp với giáo viên và mặt bằng chung của người sử dụng. Mặt 

khác, cũng giới thiệu các phần mềm khác để người sử dụng có thể trải nghiệm và 

có sự lựa chọn cho phù hợp với công việc của mình. 

Giáo trình được cấu trúc gồm 5 đơn vị bài học. Bài 1: giới thiệu tổng quan về 

e-Learning, các nguyên tắc, yêu cầu khi thiết kế bài giảng e-Learning, quy trình 

xây dựng bài giảng e-Learning. Bài 2: hướng dẫn việc lựa chọn phần mềm, cách 

tải và cài đặt các phần mềm xử lý âm thanh, video, phần mềm xây dựng bài giảng 

e-Learning. Bài 3: hướng dẫn sử dụng phần mềm xử lý âm thanh Adobe Audition. 

Bài 4: hướng dẫn sử dụng phần mềm xử lý video Camtasia Studio. Bài 5: hướng 

dẫn sử dụng phần mềm xây dựng bài giảng e-Learning Adobe Presenter. Với mỗi 

bài được trình bày theo cấu trúc: mục tiêu, nội dung, bài thực hành. 

Để hoàn thành giáo trình, nhóm tác giả trân trọng cảm ơn Ban Giám hiệu nhà 

trường, phòng Đào tạo, phòng Nghiên cứu khoa học và Hợp tác quốc tế, giảng 

viên tổ Tin học đã tạo điều kiện về cơ sở vật chất, ủng hộ về quan điểm, góp ý 

chân thành về nội dung, cách trình bày. Tuy nhiên, trong quá trình biên soạn 

không tránh khỏi những sai sót, mong được tiếp tục đón nhận sự góp ý để giáo 

trình ngày càng được hoàn thiện hơn. 

 Kon Tum, ngày…..........tháng…........... năm……  

 Tham gia biên soạn  

 1. Nguyễn Thị Lành (Chủ biên) 

 2. Trần Thị Ngọc Hà  
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GIÁO TRÌNH ĐÀO TẠO THƯỜNG XUYÊN 

MÔ ĐUN: XÂY DỰNG BÀI GIẢNG E-LEARNING  

 

I. Vị trí, tính chất, ý nghĩa và vai trò của mô đun: 

 1. Vị trí: Xây dựng bài giảng e-Learning là mô đun được tổ chức giảng dạy 

độc lập theo yêu cầu của người học. 

 2. Tính chất: Xây dựng bài giảng e-Learning là mô đun tích hợp giữa kiến 

thức lý thuyết và kỹ năng thực hành; được giảng dạy tại cơ sở đào tạo hoặc tại cơ 

quan, trường học khi có đầy đủ máy tính. 

3. Ý nghĩa và vai trò của mô đun: Mô đun này được tổ chức đào tạo theo 

nhu cầu người học, dành cho các đối tượng giáo viên, sinh viên và các đối tượng 

khác đã biết sử dụng máy tính, nội dung của mô đun được thiết kế đảm bảo tính 

tiên quyết, hướng dẫn thực hiện từng bước. 

II. Mục tiêu của mô đun:  

1. Kiến thức 

-  Trình bày được một số khái niệm liên quan bài giảng điện tử, bài giảng e-

Learning; quy trình xây dựng bài giảng e-Learning. 

-  Mô tả được các chức năng của phần mềm Microsoft PowerPoint, phần 

mềm xử lý phim, âm thanh, phần mềm tạo bài giảng điện tử e-Learning Adobe 

Presenter. 

2. Kỹ năng:  

- Sử dụng được phần mềm xử lý âm thanh, video để biên tập và tạo ra những 

đoạn audio, video phù hợp yêu cầu. 

- Sử dụng được một số tính năng của Adobe Presenter để xây dựng bài giảng 

e-Learning. 

3. Năng lực tự chủ và trách nhiệm : Rèn luyện tính kiên trì, cẩn thận, chủ 

động, sáng tạo trong việc tạo ra các học liệu cho bài giảng, thiết kế bài giảng đảm 

bảo sự tương tác cao giữa người dạy và người học. 

III. Nội dung của mô đun: 
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Bài 1: TỔNG QUAN 

Thời gian: 2 giờ 

 

Mục tiêu 

- Trình bày được mục đích, ý nghĩa việc ứng dụng CNTT trong dạy học, các 

khái niệm, thuật ngữ liên quan e-Learning, các hình thức e-Learning, nguyên tắc 

thiết kế bài giảng e-Learning,... 

- Trình bày quy trình xây dựng bài giảng e-Learning 

- Nhận diện đúng bản chất của e-Learning 

 

Nội dung: 

1. Tổng quan về ứng dụng CNTT trong dạy học 

Trong những năm gần đây, công nghệ thông tin được coi là một trong những 

ngành khoa học phát triển với tốc độ nhanh nhất. Được như vậy vì đây là một 

ngành khoa học phục vụ và mang lại hiệu quả rõ rệt cho hầu hết các ngành nghề 

khác nhau trong xã hội. Tuy vậy, tại Việt Nam, tiềm năng to lớn mà công nghệ 

thông tin có thể mang lại cho giáo dục chưa được khai thác một cách thoả đáng. 

Xét cho quá trình giáo dục, với sự đa dạng và phong phú của các phần mềm dạy 

học, công nghệ thông tin hoàn toàn có thể trợ giúp cho quá trình dạy học bởi 

những lý do dưới đây: 

Thứ nhất, việc ứng dụng công nghệ thông tin trong dạy học sẽ khiến máy 

tính trở thành một công cụ hỗ trợ đắc lực cho quá trình dạy học, cụ thể là: 

Khả năng biểu diễn thông tin: Máy tính có thể cung cấp thông tin dưới dạng 

văn bản, đồ thị, hình ảnh, âm thanh... Sự tích hợp này của máy tính cho phép mở 

rộng khả năng biểu diễn thông tin, nâng cao việc trực quan hoá tài liệu dạy học. 

Khả năng giải quyết trong một khối thống nhất các quá trình thông tin, giao 

lưu và điều khiển trong dạy học: Dưới góc độ điều khiển học thì quá trình dạy học 

là một quá trình điều khiển hoạt động nhận thức của học sinh. Với một chương 

trình phù hợp, máy tính có thể điều khiển được hoạt động nhận thức của học sinh 
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trong việc cung cấp thông tin, thu nhận thông tin ngược, xử lý thông tin và đưa ra 

các giải pháp cần thiết giúp hoạt động nhận thức của học sinh đạt kết quả cao. 

Tính lặp lại trong dạy học: Khác với giáo viên, máy tính có thể lưu trữ một 

thông tin nào đó, cung cấp và lặp lại nó cho học sinh đến mức đạt được mục đích 

sư phạm cần thiết. Trên cơ sở này, sự phát triển của từng cá thể học sinh trong quá 

trình dạy học trở thành hiện thực. Điều đó tạo điều kiện thuận lợi cho việc cá thể 

hoá trong quá trình dạy học. 

Khả năng mô hình hoá các đối tượng: Đây chính là khả năng lớn nhất của 

máy tính. Nó có thể mô hình hoá các đối tượng, xây dựng các phương án khác 

nhau, so sánh chúng từ đó tạo ra phương án tối ưu. Thật vậy, có nhiều vấn đề, hiện 

tượng không thể truyền tải được bởi các mô hình thông thường, ví như các quá 

trình xảy ra trong lò phản ứng hạt nhân, hiện tượng diễn ra trong xilanh của động 

cơ đốt trong, từ trường quay trong động cơ không đồng bộ ba pha, chuyển động 

của điện tử xung quanh hạt nhân... trong khi đó máy tính hoàn toàn có thể mô 

phỏng chúng. 

Khả năng lưu trữ và khai thác thông tin: Với bộ nhớ ngoài có dung lượng 

như hiện nay, máy tính có thể lưu trữ một lượng lớn dữ liệu. Điều này cho phép 

thành lập các ngân hàng dữ liệu. Các máy tính còn có thể kết nối với nhau tạo 

thành các mạng cục bộ hay kết nối với mạng thông tin toàn cầu Internet. Đó chính 

là những tiền đề giúp giáo viên và học sinh dễ dàng chia sẻ và khai thác thông tin 

cũng như xử lý chúng có hiệu quả. 

Thứ hai, ứng dụng công nghệ thông tin trong dạy học có thể hỗ trợ cho 

nhiều hình thức dạy học khác nhau như dạy học giáp mặt (face to face); dạy học từ 

xa (distance learning); phòng đào tạo trực tuyến (online training lab); học dựa trên 

công nghệ web (web based training); học điện tử (e-learning)...đáp ứng được nhu 

cầu học tập ngày càng cao của các thành phần khác nhau trong xã hội. 

Thứ ba, ứng dụng công nghệ thông tin trong dạy học dẫn đến việc giao cho 

máy tính thực hiện một số chức năng của người thầy giáo ở những khâu khác nhau 

của quá trình dạy học. Nhờ đó, có thể xây dựng những chương trình dạy học mà ở 
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đó máy thay thế một số công việc của người giáo viên... Cách dạy này đã thể hiện 

nhiều ưu điểm về mặt sư phạm như khuyến khích sự làm việc độc lập của học 

sinh, đảm bảo mối liên hệ ngược và cá biệt hoá quá trình học tập. 

2. E-Learning và các khái niệm 

2.1. Lịch sử phát triển e-Learning 

E-Learning (Electronic Learning) là thuật ngữ đã trở nên quen thuộc trên thế 

giới trong một vài thập kỷ gần đây. Cùng với sự phát triển của Tin học và mạng 

truyền thông, các phương thức giáo dục, đào tạo ngày càng được cải tiến nhằm 

nâng cao chất lượng, tiết kiệm thời gian và tiền bạc cho người học. Ngay từ khi 

mới ra đời, E-Learning đã xâm nhập vào hầu hết các hoạt động huấn luyện đào tạo 

của các nước trên thế giới. Tập đoàn dữ liệu quốc tế (IDG) nhận định rằng sẽ có 

một sự phát triển bùng nổ trong lĩnh vực E-Learning. Và điều đó đã được chứng 

minh qua sự thành công của các hệ thống thống giáo dục hiện đại có sử dụng 

phương pháp E-Learning nhiều quốc gia như Mỹ, Anh, Nhật,… 

Gắn với sự phát triển của công nghệ thông tin và phương pháp giáo dục đào 

tạo, quá trình phát triển của E-Learning có thể chia ra thành 4 thời kỳ như sau : 

- Trước năm 1983: 

Thời kỳ này, máy tính chưa được sử dụng rộng rãi, phương pháp giáo dục 

“Lấy giảng viên làm trung tâm” là phương pháp phổ biến nhất trong các trường 

học. Học viên chỉ có thể trao đổi tập trung quanh giảng viên và các bạn học. Đặc 

điểm của loại hình này là giá thành đào tạo rẻ. 

- Giai đoạn 1984 - 1993:  

Sự ra đời của hệ điều hành Windows 3.1, Máy tính Macintosh, phần mềm 

trình diễn powerpoint, cùng các công cụ đa phương tiện khác đã mở ra một kỷ 

nguyên mới: kỷ nguyên đa phương tiện. Những công cụ này cho phép tạo ra các 

bài giảng có tích hợp hình ảnh và âm thanh dựa trên công nghệ CBT (Computer 

Based Training). Bài học được phân phối đến người học qua đĩa CD-ROM hoặc 

đĩa mềm. Vào bất kỳ thời gian nào, ở đâu, người học cũng có thể mua và tự học. 

Tuy nhiên sự hướng dẫn của giảng viên là rất hạn chế. 
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- Giai đoạn 1994 – 1999” 

Khi công nghệ Web được phát minh ra, các nhà cung cấp dịch vụ đào tạo bắt 

đầu nghiên cứu cách thức cải tiến phương pháp giáo dục bằng công nghệ này. Các 

chương trình: E-mail, Web, Trình duyệt, Media player, kỹ thuật truyền 

Audio/video tốc độ thấp cùng với ngôn ngữ hỗ trợ Web như HTML và JAVA bắt 

đầu trở lên phổ dụng đã làm thay đổi bộ mặt của đào tạo bằng đa phương tiện. 

Người thầy thông thái đã dần lộ rõ thông qua các phương tiện: E-mail, CBT, qua 

Intranet với text và hình ảnh đơn giản, đào tạo bằng công nghệ WEB với hình ảnh 

chuyển động tốc độ thấp đã được triển khai trên diện rộng. 

- Giai đoạn 2000 đến nay 

Các công nghệ tiên tiến bao gồm JAVA và các ứng dụng mạng IP, công nghệ 

truy nhập mạng và băng thông Internet được nâng cao, các công nghệ thiết kế 

Web tiên tiến đã trở thành một cuộc cách mạng trong giáo dục đào tạo. Ngày nay 

thông qua Web, giáo viên có thể kết hợp hướng dẫn trực tuyến (hình ảnh, âm 

thanh, các công cụ trình diễn) tới mọi người học, nâng cao hơn chất lượng dịch vụ 

đào tạo. Càng ngày công nghệ Web càng chứng tỏ có khả năng mang lại hiệu quả 

cao trong giáo dục đào tạo, cho phép đa dạng hoá các môi trường học tập. Tất cả 

những điều đó tạo ra một cuộc cách mạng trong đào tạo với giá thành rẻ, chất 

lượng cao và hiệu quả. Đó chính là làn sóng thứ 2 của E-learning, và hiện nay 

chúng ta đang ở trong giai đoạn của làn sóng này. 

Cùng với xu hướng chung của thế giới, ở Việt Nam, E-Learning cũng đã 

được một số cơ quan và tổ chức đào tạo truyền bá và triển khai ứng dụng. Trên 

mạng Internet có hàng trăm trang Web cung cấp dịch vụ đào tạo theo mô hình E-

Learning, điển hình là dịch vụ luyện thi trực tuyến trên mạng của công ty phát 

triển phần mềm VASC với trang Web http://www.truongthi.com, Trung tâm đào 

tạo kỹ thuật viên mạng CISCO qua trang Web http://www.cisco.com,… Bộ khoa 

học và công nghệ cũng đã thành lập trung tâm VITEC chuyên sát hạch CNTT và 

hỗ trợ đào tạo. Một số trường đại trong nước cũng đã và đang áp dụng từng phần 

hình thức E-Learning.  
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2.2. Thuật ngữ e-Learning  

E-Learning (viết tắt của Electronic Learning) là một thuật ngữ có nhiều quan 

điểm và cách hiểu khác nhau. 

- E-Learning là sử dụng các công nghệ Web và Internet trong học tập 

(William Horton). 

- E-Learning là một thuật ngữ dùng để mô tả việc học tập, đào tạo dựa trên 

công nghệ thông tin và truyền thông (Compare Infobase Inc). 

- E-Learning nghĩa là việc học tập hay đào tạo được chuẩn bị, truyền tải hoặc 

quản lý sử dụng nhiều công cụ của công nghệ thông tin, truyền thông khác nhau 

và được thực hiện ở mức cục bộ hay toàn cục (MASIE Center).  

- Việc học tập được truyền tải hoặc hỗ trợ qua công nghệ điện tử. Việc truyền 

tải qua nhiều kĩ thuật khác nhau như Internet, TV, video tape, các hệ thống giảng 

dạy thông minh, và việc đào tạo dựa trên máy tính ( CBT ) (Sun Microsystems, 

Inc). 

- Việc truyền tải các hoạt động, quá trình, và sự kiện đào tạo và học tập thông 

qua các phương tiện điện tử như Internet, intranet, extranet, CD-ROM, video tape, 

DVD, TV, các thiết bị cá nhân... (e-learningsite).  

- Việc sử dụng công nghệ để tạo ra, đưa các dữ liệu có giá trị, thông tin, học 

tập và kiến thức với mục đích nâng cao hoạt động của tổ chức và phát triển khả 

năng cá nhân. (Định nghĩa của Lance Dublin, hướng tới e-learning trong doanh 

nghiệp). 

- E-Learning là cách thức học mới qua mạng Internet, qua đó học viên có thể 

học mọi lúc, mọi nơi, học theo sở thích và học suốt đời (EDUSOFT LTD.). 

Đặc điểm chung của E-Learning 

- Dựa trên công nghệ thông tin và truyền thông. Cụ thể hơn là công nghệ 

mạng, kĩ thuật đồ họa, kĩ thuật mô phỏng, công nghệ tính toán… 

- Hiệu quả của E-Learning cao hơn so với phương pháp học truyền thống do 

E-Learning có tính tương tác cao dựa trên đa phương tiện (multimedia), tạo điều 
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kiện cho người học trao đổi thông tin dễ dàng hơn, cũng như đưa ra nội dung học 

tập phù hợp với khả năng và sở thích của từng người. 

- E-Learning sẽ trở thành xu thế tất yếu trong nền kinh tế tri thức. Hiện nay, 

E-Learning đang thu hút được sự quan tâm đặc biệt của các nước trên thế giới. Rất 

nhiều tổ chức, công ty hoạt động trong lĩnh vực E-Learning đã ra đời. 

Hệ thống E-Learning bao gồm: 

- Đầu tiên, e-Learning có hệ thống quản lý học tập (LMS - Learning 

Management System) giúp xây dựng các lớp học trực tuyến hiệu quả. 

- Một thành phần quan trọng nữa của hệ thống e-Learning là hệ thống quản lí 

nội dung học tập (LCMS - Learning Content Management System) cho phép tạo 

và quản lý nội dung học tập. 

- Ngoài ra e-Learning còn cung cấp các công cụ làm bài giảng (authoring 

tools) một cách sinh động, dễ dùng, và đầy đủ multimedia. 

- Quan trọng hơn là e-Learning đã được thế giới chuẩn hoá nên các bài giảng 

có thể trao đổi với nhau trên toàn thế giới cũng như giữa các trường học ở Việt 

Nam. 

Ưu, nhược điểm của E-Learning trong dạy học: 

* Ưu điểm: 

- E-Learning làm biến đổi cách học cũng như vai trò của người học, người 

học đóng vai trò trung tâm và chủ động của quá trình đào tạo, có thể học mọi lúc, 

mọi nơi nhờ có phương tiện trợ giúp việc học. 

- Người học có thể học theo thời gian biểu cá nhân, với nhịp độ tuỳ theo khả 

năng và có thể chọn các nội dung học, do đó nó sẽ mở rộng đối tượng đào tạo rất 

nhiều. Tuy không thể hoàn toàn thay thế được phương thức đào tạo truyền thống, 

E-Learning cho phép giải quyết một vấn đề nan giải trong lĩnh vực giáo dục đó là 

nhu cầu đào tạo của người lao động và số lượng sinh viên tăng lên quá tải so với 

khả năng của các cơ sở đào tạo. 
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- E-Learning sẽ có sức lôi cuốn rất nhiều người học kể cả những người trước 

đây chưa bao giờ bị hấp dẫn bởi lối giáo dục kiểu cũ và rất phù hợp với hoàn cảnh 

của những người đang đi làm nhưng vẫn muốn nâng cao trình độ. 

- Các chương trình đào tạo từ xa trên thế giới hiện nay đã đạt đến trình độ 

phong phú về giao diện, sử dụng rất nhiều hiệu ứng đa phương tiện như âm thanh, 

hình ảnh, hình ảnh động ba chiều, kĩ xảo hoạt hình,… có độ tương tác cao giữa 

người sử dụng và chương trình, đàm thoại trực tiếp qua mạng. Điều này mang đến 

cho học viên sự thú vị, say mê trong quá trình tiếp thu kiến thức cũng như hiệu 

quả trong học tập. 

- E-Learning cho phép học viên làm chủ hoàn toàn quá trình học của bản 

thân, từ thời gian, lượng kiến thức cần học cũng như thứ tự học các bài, đặc biệt là 

cho phép tra cứu trực tuyến những kiến thức có liên quan đến bài học một cách tức 

thời, duyệt lại những phần đã học một cách nhanh chóng, tự do trao đổi mới 

những người cùng học hoặc giáo viên ngay trong quá trình học, những điều mà 

theo cách học truyền thống là không thể hoặc đòi hỏi chi phí quá cao. 

* Nhược điểm: 

Sự giao tiếp cần thiết giữa người dạy và người học bị phá vỡ. Người học sẽ 

không được rèn kĩ năng giao tiếp xã hội. 

Đối với những môn học mang tính thực nghiệm, E-Learning không thể đáp 

ứng yêu cầu môn học, không rèn được cho người học thao tác thực hành thí 

nghiệm, kĩ năng nghiên cứu thực nghiệm. 

2.3. Các hình thức e-Learning 

Có một số hình thức đào tạo bằng E-learning ,cụ thể như sau: 

- Đào tạo dựa trên công nghệ  (TBT- Technology -Based Training). 

- Đào tạo dựa trên máy tính (CBT -Computer- Based Training). 

- Đào tạo dưạ trên Web (WBT – Web-Based Training). 

- Đào tạo trực tuyến (Online Learning/Training). 

- Đào tạo từ xa (Distance Learning). 

2.4. Bài giảng điện tử, bài giảng E-Learning: 
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- Bài giảng điện tử: 

Bài giảng điện tử là một hình thức tổ chức bài lên lớp mà ở đó toàn bộ kế 

hoạch hoạt động dạy học đều được chương trình hoá do giảng viên điều khiển 

thông qua môi trường multimedia do máy vi tính tạo ra.  

Multimedia được hiểu là đa phương tiện, đa môi trường, đa truyền thông. 

Trong môi trường multimedia, thông tin được truyền dưới các dạng: văn bản 

(text), đồ hoạ (graphics), hoạt ảnh (animation), ảnh chụp (image), âm thanh 

(audio) và phim video (video clip). 

- Bài giảng E-Learning:  Cũng có nhiều quan niệm khác nhau về bài giảng E-

Learning được đưa ra tùy vào từng thời điểm, từng giai đoạn phát triển, nhưng 

hiện nay, bài giảng e-Learning là sản phẩm được tạo ra từ các công cụ tạo bài 

giảng (Authoring Tools), có khả năng tích hợp đa phương tiện (Multimedia) gồm 

phim (video), hình ảnh, âm thanh, hoạt hình,… và tuân thủ một trong các chuẩn 

như SCORM, AICC. 

Bài giảng E-Learning là một hình thức biểu hiện cao nhất của bài giảng điện 

tử nhưng có điểm khác biệt là bài giảng E-Learning có thể tồn tại trong môi trường 

máy tính cá nhân và tồn tại cả trong môi trường web tạo ra môi trường học tập 

rộng lớn, còn bài giảng điện tử chỉ tồn tại trong môi trường máy tính cá nhân; bài 

giảng E-Learning có thể được sử dụng để học trực tuyến (online) và học ngoại 

tuyến (off-line), người học có thể sử dụng bài giảng E-Learning để học mọi nơi, 

mọi lúc, không cần đến trường lớp và không cần giáo viên. 

Cấu trúc bài giảng E-Learning: 
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Bài giảng E-Learning được cấu trúc bởi sự liên kết giữa các nội dung của bài 

giảng với nhau và sự liên kết này được thể hiện từ chủ đề chính đến các chủ đề 

con, ở mỗi chủ đề (hoặc chủ đề con) có thể có thể có các câu hỏi, bài tập để kiểm 

tra mức độ nhận thức của người học. 

3. Yêu cầu, nguyên tắc, chuẩn khi thiết kế bài giảng điện tử 

Yêu cầu chung: 

- Phải dựa trên lí luận dạy học, đặc biệt là lí luận dạy học hiện đại. Lựa chọn 

phần mềm để hỗ trợ cho giáo viên thể hiện ý tưởng sư phạm của mình một cách 

thuận lợi và hiệu quả. 

- Cấu trúc bài dạy phải chặt chẽ, lôgic. Thông tin ngắn gọn, cô đọng, được bố 

trí và trình bày một cách khoa học phù hợp với tiến trình lên lớp 

- Thể hiện đồng bộ và hợp lí các đối tượng đa phương tiện để hỗ trợ các hoạt 

động nhận thức. 

- Bài dạy cần khuyến khích sự trao đổi giữa giáo viên và học sinh; tăng 

cường trao đổi, hợp tác giữa các học sinh; khích lệ tư duy, hoạt động độc lập, sáng 

tạo... 

- Nội dung bài dạy phải cuốn hút, đảm bảo học sinh tập trung vào nội dung, 

lôgic của kiến thức. 
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- Sử dụng bài dạy đúng kế hoạch, tiến trình với tư thế, cử chỉ, điệu bộ, giọng 

nói, ánh mắt của giáo viên hợp lý. 

Một số nguyên tắc, chuẩn khi thiết kế bài giảng điện tử 

+ Độ lớn chữ viết:  

Đây là một yếu tố cần được quan tâm nhằm đảm bảo cho tất cả người học 

có thể thu nhận thông tin một cách rõ ràng trên màn chiếu. Có thể tham khảo tiêu 

chuẩn dưới đây: 

Khoảng cách từ người quan sát  

tới màn chiếu (m) 
3 6 9 12 15 18 21 24 

Chiều cao tối thiểu của chữ (mm) 12 25 40 50 60 75 80 100 

Cần chú ý rằng, chiều cao của chữ trên màn chiếu phụ thuộc vào rất nhiều 

yếu tố như kiểu chữ, cỡ chữ, khoảng cách từ máy chiếu tới màn chiếu, khả năng 

phóng to, thu nhỏ của máy chiếu...Do vậy, tuỳ thuộc vào phòng học và trang thiết 

bị cụ thể mà chọn kiểu chữ và cỡ cữ để đáp ứng được tiêu chuẩn trên. Trong thực 

tế, nên chọn cỡ chữ tối thiểu 20pt cho kiểu chữ Arial hay tương đương; tối thiểu 

24pt cho kiểu chữ Times New Roman hay tương đương. 

Còn về kiểu chữ, nên sử dụng các kiểu chữ không chân vì đây là kiểu chữ 

dễ đọc. Nên lựa chọn và sử dụng không quá hai kiểu chữ nhằm đảm bảo tính cân 

bằng và nhất quán trong bài trình bày. Hạn chế sử dụng chữ in hoa vì nó sẽ làm 

mất hình dạng của ký tự gây khó đọc cho người quan sát. Ví dụ 

Nên dùng kiểu CHỮ KHÔNG CHÂN 

Không nên dùng kiểu chữ có chân, hình dạng phức tạp 

KHÔNG NÊN SỬ DỤNG NHIỀU NỘI DUNG BẰNG CHỮ IN HOA 

+ Đảm bảo độ tương phản: 

Để nội dung thông tin trên màn chiếu rõ ràng, dễ đọc, cần đảm bảo nguyên 

tắc phối hợp giữa mầu nền và mầu chữ. Đó là, nếu màu nền là mầu sáng thì mầu 

chữ sẽ là mầu tối và ngược lại. Có thể tham khảo một số cặp mầu chữ - nền sau: 

Mầu nền Mầu vàng Mầu trắng Mầu xanh Mầu trắng Mầu đen 
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Mầu chữ Mầu đen Mầu đỏ, Xanh Mầu trắng Mầu đen Mầu vàng 

Trong thực tế, có hai phong cách trình bày 

 Một là, mầu nền tối, mầu chữ sáng. Cách chọn này đảm bảo độ tương phản 

tốt, tuy nhiên, lớp học có thể bị tối, gây khó khăn cho học sinh ghi chép các nội 

dung, kiến thức chính 

 Hai là, mầu nền sáng, mầu chữ tối. Cách chọn này cũng đảm bảo độ tương 

phản tốt, lớp học sáng, học sinh có thể ghi chép tốt. Tuy nhiên, mầu nền sáng 

trong một thời gian dài có thể gây ức chế cho người học.  

+ Xác định vùng hiển thị thông tin quan trọng:  

Một nghiên cứu chỉ ra rằng, khi mắt người nhìn vào một hình chữ nhật thì 

sự tập trung chú ý không giống nhau với các vùng khác nhau. Theo sơ đồ này, mắt 

người sẽ tập trung chú ý nhiều nhất vào phía trên, bên trái của khung hình chữ 

nhật. Đây chính là vùng người thiết kế nên đặt những đối tượng, thông tin quan 

trọng.  

 

+ Đảm bảo yếu tố ngắt dòng:  

Việc ngắt dòng không đúng sẽ làm cho người học rất khó đọc và ghi nhớ 

thông tin trình bày. Ví dụ dưới đây sẽ minh hoạ điều này: 

Ngắt dòng không đúng Ngắt dòng đúng 

PowerPoint là một phần 

mềm ứng dụng cho 

phép thiết kế và xây 

dựng trình diễn 

PowerPoint là một phần mềm ứng dụng 

cho phép thiết kế và xây dựng trình diễn 

+ Khai thác ý nghĩa các biểu tượng:  
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Lôgo, biểu tượng không những có thể cung cấp các thông tin về người trình 

bày, về tổ chức, cá nhân...mà còn có tác dụng hỗ trợ quá trình nhận thức cho người 

học. Do vậy, trong bài trình bày, trên các slide nên sử dụng các biểu tượng phù 

hợp với nội dung được đề cập. Ví du, có thể sử dụng một biểu tượng như dưới 

đây: 

+ Mầu sắc và cấu trúc thông tin trong slide nhất quán:  

Không nên sử dụng quá nhiều mầu sắc trong một trình diễn (không quá 3 

mầu), điều này có thể khiến người học mệt mỏi. Cách bố trí các nội dung trong 

slide, mầu nền, mầu chữ nên trình bày đồng bộ.  

+ Hoạt hình các đối tượng trong slide:  

Hoạt hình các đối tượng trong slide là cách thức làm cho từng thông tin hiển 

thị phù hợp với tiến trình dạy học của người thầy. Tuy nhiên, để định hướng người 

học tập trung vào nội dung trình bày, cần thiết sử dụng các hoạt hình đơn giản, 

chân phương. 

+ Nhấn mạnh các thông tin trong slide 

 Nhấn mạnh nội dung thông tin nào đó là yêu cầu quan trọng khi thể hiện 

thông tin trong giờ dạy. Có nhiều cách thức để nhấn mạnh một nội dung nào đó 

như sử dụng chức năng hoạt hình (animation) hoặc màu sắc hoặc độ lớn.  

4. Quy trình xây dựng bài giảng e-Learning 

Quy trình xây dựng bài giảng E-Learning gồm 5 bước:  

B1. Xác định mục tiêu và kiến thức cơ bản của bài học 

B2. Xây dựng kho tư liệu phục vụ cho bài học  

B3. Xây dựng kịch bản dạy học 

B4. Lựa chọn công cụ và số hóa kịch bản 

B5. Chạy thử chương trình, sửa chữa và đóng gói bài giảng 

Để thực hiện xây dựng bài giảng cần có sự tham gia của giáo viên và nhóm 

cán bộ hỗ trợ kỹ thuật (nhóm cán bộ hiểu biết về CNTT và các công cụ thiết kế bài 

giảng). Tuy nhiên, người giáo viên có kỹ năng CNTT tốt thì có thể đóng vai trò 

của cán bộ kỹ thuật. 
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4.1. Xác định mục tiêu và kiến thức cơ bản của bài học 

Việc xác định mục tiêu và nội dung phải bám sát nội dung chương trình; 

nghiên cứu kỹ giáo trình và tài liệu tham khảo; xác định nội dung trọng tâm. 

Mục tiêu phải được xác định là mục tiêu học tập (hướng về người học), chứ 

không phải là mục tiêu giảng dạy, tức là chỉ ra sản phẩm mà học sinh có được sau 

bài học. 

Việc chọn lọc kiến thức cơ bản của bài dạy học có thể gắn với việc sắp xếp 

lại cấu trúc của bài để làm nổi bật các mối liên hệ giữa các hợp phần kiến thức của 

bài, từ đó rõ thêm các trọng tâm, trọng điểm của bài. 

4.2. Xây dựng kho tư liệu phục vụ bài giảng 

Tư liệu phục vụ bài giảng có thể là hình ảnh (ảnh quét, ảnh chụp), phim (tự 

quay hoặc biên tập từ nhiều nguồn khác nhau), âm thanh, lời giảng, … Dùng các 

phần mềm chuyên dụng để xử lý các hình ảnh, âm thanh, phim,… đảm bảo chất 

lượng về hình ảnh, âm thanh. Khi sử dụng các đoạn phim, hình ảnh, âm thanh cần 

phải đảm bảo các yêu cầu về mặt nội dung, phương pháp, thẩm mỹ và ý đồ sư 

phạm. 

Sau khi có được đầy đủ tư liệu cần dùng cho bài giảng điện tử, phải tiến hành 

sắp xếp tổ chức lại thành thư viện tư liệu, tức là tạo được cây thư mục hợp lý. Cây 

thư mục hợp lý sẽ tạo điều kiện tìm kiếm thông tin nhanh chóng và giữ được các 

liên kết trong bài giảng đến các tập tin âm thanh, video clip khi sao chép bài giảng 

từ ổ đĩa nay sang ổ đĩa khác, từ máy này sang máy khác. 

4.3. Xây dựng kịch bản bài giảng 

Ở bước này, cần thực hiện chi tiết và cần phải tuân thủ các nguyên tắc sư 

phạm, nội dung cơ bản, đảm bảo mục tiêu bài học (cả về mặt kiến thức và kỹ 

năng). 

Thực hiện các bước trong các nhiệm vụ dạy học: Xây dựng các bước dạy 

học, xây dựng sự tương tác người dạy và người học, xây dựng các câu hỏi tương 

tác, lắp ghép các bước lại thành quá trình dạy học. 

4.4. Lựa chọn công cụ và số hóa kịch bản 
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Tiêu chí cần căn cứ vào nhu cầu của người sử dụng, căn cứ vào nguồn tài 

chính, căn cứ vào trình độ của cán bộ kỹ thuật sử dụng công cụ như thế nào. 

Các công cụ: có nhiều công cụ, chẳng hạn Adobe Presenter, Lecture Marker, 

iSpring,…tuy nhiên một phần mềm được nhiều giáo viên sử dụng đó là Adobe 

Presenter vì nó có khả năng tích hợp với Powerpoint nên nó tạo ra tính thân thiện 

và gần gũi đối với giảng viên. 

Các bước để số hóa kịch bản: Xây dựng được bài giảng bằng MS 

Powerpoint. Quá trình xây dựng phải đảm bảo các bước trong quá trình dạy học; 

Ghi âm, thu hình (quay video giảng viên giảng bài); Biên tập video, âm thanh; Sử 

dụng phần mềm để đồng bộ bài giảng. 

4.5. Chạy thử chương trình, sửa chữa và đóng gói sản phẩm 

Công việc gồm: chạy thử chương trình, kiểm soát lỗi và chỉnh sửa bài giảng. 

Sau đó, đóng gói bài giảng theo định dạng phù hợp với mục đích yêu cầu. Kết thúc 

bước này ta đã có sản phẩm bài giảng trực tuyến. 

Trong mỗi bước của quy trình trên, người thực hiện có thể là giảng viên hoặc 

nhóm kỹ thuật hoặc cả hai. Cần phải có sự phối hợp đồng bộ giữa giảng viên và 

nhóm kỹ thuật. 
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Bài 2. CÀI ĐẶT PHẦN MỀM 

Thời gian: 4 giờ 

 

Mục tiêu 

 - Trình bày được các bước cài đặt các phần mềm  

 - Biết lựa chọn, tải về và cài đặt phần mềm xử lý, âm thanh, Video. 

 

Nội dung: 

Thông thường khi cài đặt một phần mềm, chúng ta cần biết yêu cầu tối thiếu 

về máy tính để cài đặt phần mềm, nếu phần mềm có bản quyền thì phải biết key 

hoặc số series, bắt đầu cài đặt với việc chạy file Setup.exe (hoặc Install.exe) và 

thực hiện các bước theo hướng dẫn (thường thì chọn nơi lưu trữ các file cài đặt, 

nhập key hoặc series, đồng ý với những thỏa thuận, next,…). Nếu phần mềm yêu 

cầu phải có phần mềm khác bổ trợ hoặc làm nền tảng thì phải cài bổ sung thêm 

phần mềm bổ trợ hoặc nền tảng theo yêu cầu. 

1. Cài đặt phần mềm Adobe Presenter 

Có nhiều phần mềm để cài đặt bài giảng E-Learning như: Adobe Presenter, 

Lecture Marker, iSpring,… 

Trong bài giảng này sẽ hướng dẫn cài đặt và sử dụng phần mềm Adobe 

Presenter. 

Phần mềm Adobe Presenter có khả năng tích hợp với Powerpoint (Plug-in 

trong PowerPoint), giúp người sử dụng kế thừa các slide đã thiết kế trên 

PowerPoint để phát triển thành bài giảng E-Learning. 

Adobe Presenter có nhiều phiên bản: 7, 9, 10, 11. Để xuất bản bài giảng với 

chuẩn HTML5 thì nên dùng Adobe Presenter 10 trở lên. 

1.1. Tải phần mềm: 

Đây là phần mềm có bản quyền của hãng Adobe, có thể tải về bản dùng thử 

30 ngày hoặc đăng kí mua với giá 199 USD tại địa chỉ:  

http://www.adobe.com/products/presenter/  

http://www.adobe.com/products/presenter/
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Hoặc có thể tải về từ tài nguyên của mạng giáo dục EduNet 

 http://edu.net.vn/media/g/cong-cu-soan-bai-giang/default.aspx 

1.2. Hướng dẫn cài đặt:  

1.2.1.Yêu cầu máy tính để cài đặt Adobe Presenter 

Tối thiểu 2GB Ram 

Ổ cứng trống 1GB để cài đặt, và 5GB trong quá trình sử dụng 

Độ phân giải màn hình tối thiểu 1024 x 768 (khuyến cáo 1280 x 720) 

Trình duyệt Internet Explorer 8.x, Mozilla Firefox 3.x, Safari 4.x 

Phần mềm Adobe Reader để xem nội dung trong khi thuyết trình 

Windows Media Player 

Adobe Flash Player 

Microsoft PowerPoint 2007 hoặc 2010 (32 bit) để cài đặt Adobe Presenter 

32 bit,  

Microsoft PowerPoint 2010 (64 bit) dành cho Adobe Presenter 64 bit 

Microsoft XML Library 4.0 

QuickTime: Phần mềm bổ trợ để chèn file Video, âm thanh trong 

Presenter. 

1.2.2. Hướng dẫn cài đặt Adobe Presenter 11 

Bước 1: Kích đúp chuột vào file Setup.exe để cài đặt chương trình. Tại cửa 

sổ giao diện chọn Install để cài đặt nếu đã mua bản quyền, hoặc chọn Try để cài 

dùng thử, trong tài liệu này hướng dẫn cài dùng thử. 

http://edu.net.vn/media/g/cong-cu-soan-bai-giang/default.aspx
http://www.download.com.vn/internet+email+tools/web+browser/10624_internet-explorer-8.aspx
http://www.download.com.vn/internet+email+tools/web+browser/14542_firefox.aspx
http://www.download.com.vn/internet+email+tools/web+browser/7299_safari.aspx
http://www.download.com.vn/timkiem/adobe+reader/index.aspx?platformid=Windows
http://www.download.com.vn/audio+video/audio+player/5157_windows-media-player-11.aspx
http://www.download.com.vn/audio+video/audio+player/6735_quicktime.aspx
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Bước 2: Bấm chuột vào nút Sign In.  

 

Bước 3: Bấm chuột chọn Sign In Later.  

 

 

https://1.bp.blogspot.com/-qHWyhjdayvw/WNkXRzC8rqI/AAAAAAAAJr0/MRgXYQF2Mi0-EwWwFe6mRTUlWRxRHJOcgCLcB/s1600/Adobe%2BPresenter%2B11%2Bfull%2B1.png
https://1.bp.blogspot.com/-qHWyhjdayvw/WNkXRzC8rqI/AAAAAAAAJr0/MRgXYQF2Mi0-EwWwFe6mRTUlWRxRHJOcgCLcB/s1600/Adobe%2BPresenter%2B11%2Bfull%2B1.png
https://3.bp.blogspot.com/-Oxybo6Lx66Y/WNkXTrHSmdI/AAAAAAAAJsY/cxnX1SnmRBkWv85O1ix2CXrc_P2MU6NGQCLcB/s1600/Adobe%2BPresenter%2B11%2Bfull%2B2.png
https://3.bp.blogspot.com/-Oxybo6Lx66Y/WNkXTrHSmdI/AAAAAAAAJsY/cxnX1SnmRBkWv85O1ix2CXrc_P2MU6NGQCLcB/s1600/Adobe%2BPresenter%2B11%2Bfull%2B2.png
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Bước 4: Bấm chọn Accept.  

 

Bước 5: Bấm chuột vào nút Install để bắt đầu cài đặt chương trình.  

 

 

https://1.bp.blogspot.com/-8JoWhmscDQQ/WNkXT0z9huI/AAAAAAAAJsc/n45nxWvDxxU1tIiITqAR-owTeMB-RRjEQCLcB/s1600/Adobe%2BPresenter%2B11%2Bfull%2B3.png
https://1.bp.blogspot.com/-8JoWhmscDQQ/WNkXT0z9huI/AAAAAAAAJsc/n45nxWvDxxU1tIiITqAR-owTeMB-RRjEQCLcB/s1600/Adobe%2BPresenter%2B11%2Bfull%2B3.png
https://3.bp.blogspot.com/-la3APrNkOpM/WNkXTwyWcLI/AAAAAAAAJsg/6dSr5PO3VqA6MXTVfsQHaoFuLdpqOdkwgCLcB/s1600/Adobe%2BPresenter%2B11%2Bfull%2B4.png
https://3.bp.blogspot.com/-la3APrNkOpM/WNkXTwyWcLI/AAAAAAAAJsg/6dSr5PO3VqA6MXTVfsQHaoFuLdpqOdkwgCLcB/s1600/Adobe%2BPresenter%2B11%2Bfull%2B4.png
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Bước 6: Chờ khoảng chương trình chạy cài đặt hoàn tất rồi bấm vào 

nút Launch Now.  

 

Sau khi hoàn tất việc cài đặt, Adobe Presenter sẽ được Plug-in vào 

PowerPoint ở dạng menu mở rộng, khi mở PowerPoint ta sẽ có giao diện như sau: 

 

 

 

 

https://4.bp.blogspot.com/-4ynSkA1EkjM/WNkXUQRpPNI/AAAAAAAAJsk/sRYfRRS9YakSh8Iy9AQshRqKYB7ZgNHOgCLcB/s1600/Adobe%2BPresenter%2B11%2Bfull%2B5.png
https://4.bp.blogspot.com/-4ynSkA1EkjM/WNkXUQRpPNI/AAAAAAAAJsk/sRYfRRS9YakSh8Iy9AQshRqKYB7ZgNHOgCLcB/s1600/Adobe%2BPresenter%2B11%2Bfull%2B5.png
https://4.bp.blogspot.com/-2r_tN8ZnqfM/WNkXUbCC92I/AAAAAAAAJso/AxsUFHQHD7IrGv7GdvXq1HbWd9Gzv3fMgCLcB/s1600/Adobe%2BPresenter%2B11%2Bfull%2B6.png
https://4.bp.blogspot.com/-2r_tN8ZnqfM/WNkXUbCC92I/AAAAAAAAJso/AxsUFHQHD7IrGv7GdvXq1HbWd9Gzv3fMgCLcB/s1600/Adobe%2BPresenter%2B11%2Bfull%2B6.png
https://1.bp.blogspot.com/-JJyeIYyXaKA/WNkXUr3hnII/AAAAAAAAJss/qDTD_JqslC8IB-f8-pf__spgLRCxFIiIQCLcB/s1600/Adobe%2BPresenter%2B11%2Bfull%2B7.png
https://1.bp.blogspot.com/-JJyeIYyXaKA/WNkXUr3hnII/AAAAAAAAJss/qDTD_JqslC8IB-f8-pf__spgLRCxFIiIQCLcB/s1600/Adobe%2BPresenter%2B11%2Bfull%2B7.png
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1.2.3. Cài đặt phần mềm bổ trợ Quick time 

Nếu máy tính chưa được cài đặt phần mềm bổ trợ đọc video khi chèn video 

vào bài giảng e-Learning thì chúng ta phải cài đặt phần mềm QuickTime 

Chúng ta vào google tìm kiếm và tải về phần mềm QuickTime, kích đúp 

chuột vào file cài đặt sau đó sẽ được như hình 

 

 Chọn Next và xuất hiện một cửa sổ mới 

 

Chọn Yes 

https://4.bp.blogspot.com/-McC0TLzZC5Y/Vtu_p7Pef8I/AAAAAAAAGOM/JmpPRzFLerM/s1600/8.png
https://4.bp.blogspot.com/-McC0TLzZC5Y/Vtu_p7Pef8I/AAAAAAAAGOM/JmpPRzFLerM/s1600/8.png
https://3.bp.blogspot.com/-bT4LrfgeRYo/Vtu_qCrnoYI/AAAAAAAAGOQ/pGBW63aI4qE/s1600/9.png
https://3.bp.blogspot.com/-bT4LrfgeRYo/Vtu_qCrnoYI/AAAAAAAAGOQ/pGBW63aI4qE/s1600/9.png
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Chọn Install 

Chờ đợi chương trình cài đặt, sau  đó kích vào Finish để hoàn tất 

1.3. Cài đặt: thực hành cài đặt trực tiếp trên máy tính. 

2. Cài đặt phần mềm xử lý âm thanh 

Chất lượng của 1 bản thu âm phụ thuộc vào nhiều yếu tố như con người, thiết 

bị thu âm, không gian và kĩ thuật,… Phần mềm thu âm – xử lí âm thanh cũng là 1 

trong các yếu tố quan trọng góp phần tạo nền những bản thu âm chất lượng như 

mong đợi. 

Hiện nay, có nhiều phần mềm xử lý âm thanh, tuy nhiên tùy thuộc vào mục 

đích, yêu cầu của công việc mà cần lựa chọn phần mềm để xử lý âm thanh đáp 

ứng yêu cầu. 

Sau đây là 5 phần mềm thu âm – xử lí hình ảnh bạn có thể tham khảo và lựa 

chọn cho mình trong quá trình thu âm. 

1/ Audacity 

Đây là 1 phần mềm miễn phí trên nền tảng mã nguồn mở bạn có thể sử dụng 

phần mềm rất dễ dàng và thuận lợi có thể chỉnh sửa nhiều loại tập tin như Mp3, 

wave, ogg… theo sở thích trước khi sử dụng. Ngoài ra tính năng căn bằng về âm 

lượng hay loại hệ thống loại bỏ tạp âm cũng rất chất lượng nên bạn hoàn toàn có 

thể sử dụng phần mềm này trong quá trình thu âm cho mình 

https://3.bp.blogspot.com/-t4rd1Nxedjs/Vtu_peKISnI/AAAAAAAAGOA/9G8J_q1eN3A/s1600/10.png
https://3.bp.blogspot.com/-t4rd1Nxedjs/Vtu_peKISnI/AAAAAAAAGOA/9G8J_q1eN3A/s1600/10.png
https://ksmedia.vn/huong-dan-thu-am-bang-micro-de-dang-tai-nha/
https://ksmedia.vn/huong-dan-thu-am-bang-micro-de-dang-tai-nha/
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Phần mềm thích hợp cho những ai thích thu âm tại nhà với nền tảng cá 

nhân… 

2/  Adobe Audition 

Adobe Audition là phần mềm xử lý âm thanh chuyên nghiệp hơn, ngoài các 

tính năng cơ bản như thu âm, lọc nhiễu, … còn có những tính năng nâng cao mà 

các phần mềm khác không có như cắt, ghép, trộn và chỉnh sửa đặc biệt nó hỗ trợ 

thêm nhiều hiệu ứng, xuất bản ra nhiều định dạng khác nhau. 

3/ Avid Pro Tools 

Phần mềm xử lí âm thanh này thuộc dạng DAW cho phép biên tập và chỉnh 

sửa âm thanh theo sở thích 1 cách tuyệt vời và hoàn hảo, tuy nhiên phần mềm này 

không được cho là phù hợp lắm với trình độ nghiệp dư mà nó thích hợp hơn cho 

những người có kinh nghiệm cao và phục vụ cho những dự án lớn… và chuyên 

nghiệp 

4/ Reaper 

Phần mềm xử lí hình ảnh Reaper này cũng thuộc dạng DAW cũng hỗ trợ rất 

nhiều tính năng cho phép bạn chỉnh sửa 1 cách linh hoạt những bản thu âm của 

mình và khả năng biên tập âm thanh vượt trội. Phần mềm cho phép chỉnh sửa với 

độ tùy biến cao 

Công cụ này hỗ trợ nhiều plugin khác giúp bạn có thể mở rộng khả năng làm 

việc và sử dụng 1 cách dễ dàng cho dù bạn là người không chuyên. 

Phần mềm xử lí âm thanh Reaper này có 2 phiên bản cho bạn lựa chọn đó chính là 

bản hạn chế dùng cho cá nhân và dự án nhỏ. Và bản full dùng cho những dự án 

lớn và dân chuyên nghiệp…bạn có thể lựa chọn mỗi bản cho mục đích và khả 

năng của mình. 

5/ Ableton Live 

Vẫn là các tính năng phổ biến như chỉnh sửa và tạo âm thanh. Phầm mềm 

thuộc dang DAW có những chức năng phổ biến mạnh mẽ giúp có thể xử lí âm 

thanh 1 cách hoàn hảo. Ứng dụng này tích hợp nhiều tính năng nâng cao rất phức 
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tạp nếu như bạn không chuyên sẽ gặp rất nhiều khó khăn trong quá trình sử dụng 

và không thể làm chủ được phần mềm. 

Trong tài liệu này, hướng dẫn cài đặt phần mềm Adobe Audition 

2.1. Tải phần mềm 

Có thể vào google để tìm kiếm và tải về phần mềm Adobe Audition từ nhiều 

trang Web khác nhau. Đối với những người cần phải làm việc thường xuyên về âm 

thanh thì có thể mua phần mềm bản quyền chính hãng. Đối với sinh viên hoặc 

những người nghiệp dư có thể tải phần mềm miễn phí dùng thử 30 ngày. 

Adobe Audition có nhiều phiên bản khác nhau 1.0, 1.5, 2.0, 3.0  

2.2. Hướng dẫn cài đặt 

2.2.1. Yêu cầu máy tính cài đặt: 

Hệ điều hành Windows XP trở lên  

RAM 1GB trở lên 

700MB trống trong ổ cứng (tốt nhất với 5.5GB trở lên) 

Độ phân giải màn hình 1024x768 (tốt nhất với 1280x1024) 

Card âm thanh với DirectSound hoặc ASIO drivers (tốt nhất với card âm 

thanh ASIO hỗ trợ multitrack) 

Ổ đĩa CD-ROM (hoặc DVD-ROM) 

Ổ đĩa CD-RW để ghi CD sản phẩm 

Tai nghe hoặc loa 

Đường điện thoại hoặc Internet để kích hoạt sản phẩm. 

2.2.2. Cài đặt Adobe Audition 3.0 

Sau khi tải phần mềm về, thực hiện giải nén, chạy file Audition 3.0 

Setup.exe, thực hiện theo hướng dẫn của chương trình: 

- Chọn ngôn ngữ -> OK (mặc định là English) 

 

https://vi.wikipedia.org/wiki/Windows_XP
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- Kích Next để tiếp tục 

 

- Kích Accept 

 

- Nhập tên người sử dụng và tổ chức (có thể bỏ qua) và kích Next 

 

- Kích Next để tiếp tục 
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- Kích Next để tiếp tục 

 

- Kích Install để cài đặt 

 

 

- Kích Finish để hoàn tất việc cài đặt 
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2.3. Cài đặt: thực hành cài đặt trực tiếp trên máy tính. 

3. Cài đặt phần mềm xử lý video 

Muốn tạo một video cho mình từ những hình ảnh, âm thanh, video có sẵn hay 

muốn chỉnh sửa một video có sẵn và cũng có thể là ghép nối từ rất nhiều video 

khác nhau tạo ra một video mới, có nhiều phần mềm xử lý video từ đơn giản đến 

chuyên nghiệp, vấn đề là người sử dụng lựa chọn phần mềm phù hợp để xử lý 

công việc của mình, sau đây xin giới thiệu một số phần mềm xử lý video: 

1. Windows Movie Maker: là phần mềm miễn phí dành cho Windows, sử 

dụng Windows Movies Maker khá đơn giản, không cần thao tác nhiều mà vẫn có 

thể chỉnh sửa được video bằng các phương pháp kéo thả hình ảnh, video, ngoài ra 

bạn có thể cho thêm các hiệu ứng cho video, cắt ghép cũng như chèn thêm nhạc và 

đoạn text,.... , Windows Movies Maker cho phép xuất bản video với định dạng 

wmv và hỗ trợ video đầu vào với định dạng avi, wmv, asf, mpg... 

2. ProShow Gold: 

ProShow Gold có thế mạnh là cho phép tạo video từ ảnh có sẵn, từ thêm các 

hiệu ứng hình ảnh, Proshow Gold hỗ trợ chèn thêm nhạc nền cho video. Từ đó có 

thể chi sẻ với bạn bè hoặc có thể ghi ra đĩa DVD để lưu trữ. ProShow Gold được 

nhiều bạn trẻ sử dụng để tạo những album ảnh cưới, những hình ảnh kỷ niệm với 

nhiều hiệu ứng đẹp, hỗ trợ nhiều định dạng ảnh phổ biến hiện nay. Tuy nhiên phần 

mềm này cũng không được cung cấp miễn phí. 

3. Proshow Producer: 

http://taimienphi.vn/download-windows-movie-maker-lam-video-194
http://taimienphi.vn/download-windows-movie-maker-lam-video-194
http://taimienphi.vn/download-proshow-gold-lam-video-phim-26
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Proshow Producer tương tự như Proshow Gold nhưng được tích hợp nhiều 

hiệu ứng, công cụ hỗ trợ chỉnh sửa video hơn, Proshow Producer cũng có hiệu 

suất xử lý tốt hơn, cung cấp nhiều tính năng với nhu cầu sử dụng của người dùng. 

4. Camtasia Studio 

Camtasia Studio là công cụ dùng để quay phim chụp ảnh màn hình máy tính, 

ngoài ra còn hỗ trợ các tính năng chỉnh sửa video rất chuyên nghiệp, hỗ trợ nhiều 

định dạng phổ biến hiện nay, phù hợp với giáo viên, sinh viên trong quá trình 

giảng dạy và làm bài giảng, tư liệu dạy học. Camtasia Studio cũng không miễn phí 

cho người sử dụng. 

5. CyberLink PowerProducer 

CyberLink PowerProducer cho phép tạo có thể chỉnh sửa, tạo đĩa DVD hoặc 

Blu-ray với chất lượng tốt nhất, chúng cung cấp cho bạn rất nhiều các hiệu ứng 

đồng thời, CyberLink PowerProducer còn cho phép bạn những tùy chỉnh về hình 

ảnh chất lượng cao rồi từ đó áp dụng vào Video của mình một cách nhanh chóng 

và chính xác. 

Với giao diện trực quan, dễ sử dụng bạn có thể nhanh chóng loại bỏ những 

đoạn video thừa như cắt bỏ những đoạn quảng các, hoặc loại bỏ những đoạn 

không càn thiết. CyberLink PowerProducer có khả năng làm việc với các Video, 

hình ảnh, âm thanh có các định dạng khác nhau, bao gồm cả những Video, hình 

ảnh chất lượng cao theo chuẩn 3D. 

Trong giáo trình này, chúng tôi hướng dẫn cài đặt và sử dụng phần mềm 

Camtasia 8.0 của TechSmith. 

3.1. Tải phần mềm 

Vào google để tìm kiếm và có thể tải về phần mềm Camtasia studio tại các 

trang web: 

https://camtasia-studio.vi.softonic.com/ 

http://taimienphi.vn/download-techsmith-camtasia-studio-1747 

https://download.com.vn/camtasia-studio/download 

3.2. Hướng dẫn cài đặt  

http://taimienphi.vn/download-proshow-producer-2563
http://taimienphi.vn/download-cyberlink-powerproducer-2550
https://camtasia-studio.vi.softonic.com/
http://taimienphi.vn/download-techsmith-camtasia-studio-1747
https://download.com.vn/camtasia-studio/download


35 

 

3.2.1. Yêu cầu máy tính 

- Hệ Windows XP/Vista/7/8.  

- Cần có sự hỗ trợ tốt nhất từ Microsoft DirectX 9 hoặc cao hơn bao gồm cả 

Microsoft .NET 4.0 trở lên.  

- Bộ vi xử lý tối thiểu là Dual-core trở lên  

- RAM 2GB  trở lên.  

- Bộ nhớ HDD tối thiểu 2GB 

- Màn hình hiển thị thấp nhất là 1024×768.  

- Microphone, speaker để thu âm và nghe lại khi phát video. 

3.2.2. Hướng dẫn cài đặt Camtasia Studio 8 

Bước 1: Nhấn đúp chuột vào file cài đặt, cửa sổ cài đặt xuất hiện 

nhấn Next để bắt đầu quá trình cài đặt. 

 

Bước 2: Cửa sổ thông báo các điều khoản sử dụng phần mềm xuất hiện. Tích 

chọn vào ô I accept the license agreement để đồng ý với các điều khoản mà nhà 

sản xuất đưa ra. Sau đó nhấn Next để tiếp tục cài đặt. 

http://www.download.com.vn/camtasia-studio/download
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Bước 3: Tiếp tục nhấn Next... Next theo hướng dẫn rồi nhấn Finish để hoàn 

tất quá trình cài đặt. 

3.3. Cài đặt: Thực hành cài đặt trực tiếp trên máy tính 
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Bài 3. SỬ DỤNG PHẦN MỀM XỬ LÝ ÂM THANH 

Thời gian: 18 giờ 

 

Mục tiêu 

 - Trình bày được các tính năng của phần mềm xử lý âm thanh 

 - Sử dụng được các tính năng của phần mềm để biên tập âm thanh từ âm 

thanh có sẵn, ghi âm, lọc nhiễu,... ; Xuất bản âm thanh theo định dạng mong 

muốn. 

 - Rèn luyện tính chính xác, sáng tạo. 

Nội dung: 

1. Khởi động, giao diện phần mềm xử lý âm thanh Adobe Audition 3.0 

Sau khi phần mềm đã được cài đặt trên máy tính. Để khởi động phần mềm từ 

Desktop: kích đúp vào biểu tượng từ Desktop hoặc kích chuột vào Start -> chọn 

Adobe Audition 3.0  

 

 

 

Xuất hiện giao diện phần mềm như sau: 
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Menu Effects bao gồm các chức năng chỉnh sửa, lọc âm thanh cụ thể sau: 

- Amplitude and Compression: Biên độ và giải nén. Trong phần này thường 

sử dụng chức năng Dynamics Process - tác dụng nén và gom âm thanh lại nhằm 

ổn định dao động của âm thanh. 

Hệ thống menu 

Chế độ Ghi âm 

đơn và chỉnh 

sửa 
Chế độ ghi 

âm đa track 

Các chức năng 

chỉnh sửa, lọc 

âm thanh 

Các nút điều khiển  Nút Record  
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- Delay and Echo: Phần này tạo chiều rộng âm thanh hiệu quả 

Delay effect nó là một loại hiệu ứng âm thanh, tín hiệu sẽ được lưu lại vào 

một loại bộ nhớ rồi được phát lại sau một khoảng thời gian nhất định. Tín hiệu này 

có thể phát lại một hoặc nhiều lần. Delay là effect cơ sở để phát triển thêm các loại 

Effect khác như: Chorus, Reverb, Echo, Flanging, Looping….vv. 
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Với Echo Level để tạo độ lặp lại âm thanh cho track âm thanh chính, nhiều ít 

tùy vào Feedback là tốc độ lặp và delay time tạm hiểu là số lần lặp. 
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- Filter and EQ: Filter and EQ có tác dụng lọc và tăng giảm các tần số âm 

thanh trầm bổng (bass,treble).  

 

Graphic Equalizer tách dụng tăng giảm tần số âm thanh trầm bổng.  

Effects Parametrich equalizer thì tùy vào loại mic mà chỉnh âm thanh, mid-

bass nhiều thì người ta thường cắt các tần số thấp. Chỉnh các điểm giảm theo ý 

muốn, nhưng nhớ là các tần số không nên để cao.  

- Modulation:  
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Trong phần này Effect hay sử dụng là Chorus, hiệu ứng này có tác dụng làm 

dày âm thanh  phù hợp với mix rap hoặc bè. 

 

-  Phần Reverb:  

Phần này có tác dụng tạo hiệu quả chiều sâu cho âm thanh với Effect đáng 

quan tâm là Reverb, Full Reverb và Studio reverb. 
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 Ngoài ra, hai tính năng hiển thị chính ở màn hình làm việc Audition là Main 

và Mixer 

Cửa sổ làm việc của tab Main 

Cửa sổ làm việc của tab Mixer 
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2. Ghi âm: 

Có 2 chế độ ghi âm, ghi âm ở chế độ đơn (Edit View: Sử dụng trong trường 

hợp chỉ ghi âm lời giảng) và nhiều track (Multi track View: sử dụng trong trường 

hợp muốn ghi âm lời giảng kết hợp với nhạc nền) 

2.1. Ghi âm ở chế độ đơn  

Bước 1: Kích chuột vào nút Edit trên giao diện -> Vào menu File-> chọn 

New   

Bước 2: Thiết lập tần số, channel… -> OK, file âm thanh mới được tạo ra với 

tên Untitled 
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Bước 3: Kích nút Record để bắt đầu thu âm, trong quá trình thu kích nút Stop 

hoặc Record để kết thúc thu âm. 

 

 

2.1. Ghi âm ở chế độ nhiều Track  

3 

1 

2 
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Để thu âm với nhiều Track thì kích vào nút Multitrack để bật chế độ 

Multitrack và chọn từng track để đưa âm thanh vào. 

Bước 1: Import nhạc nền vào track 1 (có thể đưa nhạc nền vào track 2 hoặc 

track 3), bằng cách kích nút phải chuột lên khoảng trống ở track 1 -> Insert -> 

Audio -> tìm và chon  file nhạc nền -> chọn Open để chèn file nhạc nền vào track 

1 

 

Bước 2: Ghi âm lời giảng vào track2 (hoặc track khác tùy ý), bằng cách kích 

vào biểu tượng R màu đỏ ở track 2, chương trình sẽ yêu cầu đặt tên cho 

session, đặt tên cho session rồi bấm Save 

 

 

Tương tự khi muốn bè ờ track 3 thì click vào nút R ở track 2 một lần nữa để 

tắt ghi âm ở track 2, rồi click vào nút R ở track 3 và thu âm ở track 3. 

Có thể nghe lại bằng các nhấn vào nút Play ở phần Transport. 
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3. Lưu, mở file âm thanh 

3.1. Lưu file âm thanh 

Kích menu File -> Save As -> chọn nơi để lưu, gõ tên file 

Chọn kiểu file ở ô Save as type : nên lưu thành 2 file: 1 file có đuôi WAV 

(xem như file gốc vì chất lượng âm thanh tốt hơn, nhưng kích thước lớn hơn), 1 

file có đuôi MP3 (file nén có kích thước nhỏ để dễ dàng đưa lên Web hoặc tương 

thích với phần mềm e-Learning)  

 

3.2. Mở file âm thanh 

Kích menu File -> Open -> tìm đến file để mở 

4. Biên tập âm thanh 

Sau khi ghi âm xong, tiến hành xóa bỏ những đoạn âm thanh thừa, lọc nhiễu, 

tiếng xè, hoặc cắt ghép 1 số đoạn âm thanh,… 

4.1. Lọc tạp âm. 

Khi thu âm với môi trường có nhiều tiếng ồn, tiếng xè, để loại bỏ ta thực hiện 

theo các bước sau: 

Bước 1: Lấy mẫu tạp âm 
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Thông thường khi bắt đầu ghi âm nên để im lặng khoảng 2, 3 giây đầu tiên, 

để những tạp âm được thu vào, nó sẽ được lấy làm “Mẫu tạp âm”  và những âm 

thanh có tần số như mẫu này sẽ được lọc đi. 

Chọn đoạn âm thanh chỉ có tạp âm (chiều dài khoảng này chỉ cần 1s là đủ),  

Effects --> Noise Reduction --> Capture Noise Reduction (phím tắt Alt 

+N) rồi  OK hoặc kích nút chuột phải tại vùng đã chọn và chọn Capture Noise 

Reduction Profile -> tiến trình lấy mẫu sẽ được thực hiện 

Lưu ý: Nếu đang thu âm ở chế độ Multitrack thì chuyển về chế độ Edit, kích 

đúp vào track muốn lọc 

 

 

Bước 2: Đánh dấu toàn bộ file âm thanh (Ctrl-A) để chuẩn bị áp dụng chức 

năng lọc tạp âm 

Bước 3: Vào menu Effects -> Noise Reduction -> Noise Reduction  
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Hộp thoại Noise Reduction hiện ra. Nhấn OK để bắt đầu thực hiện. (Có thể 

nghe thử trước đó bằng nút Preview)  
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4.2. Xoá bỏ đoạn âm thanh: 

Chúng ta có thể xóa bỏ đoạn âm thanh dư thừa sau khi thu âm hoặc trong 1 

file âm thanh có sẵn, ta muốn giữ lại một số đoạn âm thanh cần thiết và xóa bỏ 

một số đoạn không cần thiết, bằng cách: dùng chuột để chọn đoạn âm thanh muốn 

xoá -> bấm phím delete. 

4.3. Sao chép đoạn âm thanh 

- Sao chép trong cùng file âm thanh: Chọn đoạn âm thanh muốn sao chép -> 

kích nút phải chuột -> chọn Copy -> kích chuột vào nơi muốn chép đến -> Paste 

 - Sao chép đoạn âm thanh ra file mới: Chọn đoạn âm thanh muốn sao chép -

> kích nút phải chuột -> chọn Copy to new 

4.4. Di chuyển đoạn âm thanh 

Chọn đoạn âm thanh muốn di chuyển -> kích nút phải chuột -> chọn Cut -> 

kích chuột vào nơi muốn chép đến -> Paste 

4.5. Mix âm  

Mix âm là việc điều chỉnh các thông số về độ trầm, bỗng, độ ấm, độ sắc nét, 

thêm tiếng lặp,  vang, làm đều âm thanh…  

- Điều chỉnh độ trầm, độ ấm, độ sắc nét,…  

Chọn phần âm thanh cần điều chỉnh, về chế độ Edit view, vào Effects -> 

chọn Filter and EQ Graphic Equalizer 
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Click vào nút 20 bands để có thể chỉnh ở nhiều băng tần hơn, những cột bên 

phải là những cột dùng để chỉnh treble, bên trái là bass, ở giữa là những âm ở tầng 

trung (midle). Có thể nghe thử bằng cách nhấn vào nút Play (hình tam giác ở góc 

dưới bên trái cửa sổ để nghe thử và điều chỉnh), sau khi đã vừa ý nhấn vào Ok. 

- Điều chỉnh âm thanh to nhỏ (volume): Nếu muốn nhạc nền nhỏ lại và lời 

giảng to hơn nhạc nền thì bôi đen phần nhạc nền và điều chỉnh volume nhỏ ở phía 

trên (hoặc vào menu Effects -> chọn Amplitude and Compression -> điều chỉnh 

thanh trượt để tăng giảm âm lượng) 

Có thể chỉnh âm lượng to nhỏ từng đoạn bằng cách bôi đen từng đoạn đó rồi 

làm như trên 
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Ngoài ra, có thể điều chỉnh các hiệu ứng khác như Reverb, delay, echo,… 

cho đoạn âm thanh. Để điều chỉnh cho hài hòa giữa nhạc nền và âm thanh đã thu, 

ta bật Mixer lên để điều chỉnh. 

Với việc mix âm, các thông số chúng ta tự điều chỉnh và cảm nhận thực tế 

với âm thanh mình đang mix và thường xuyên nghe đi nghe lại khi điều chỉnh để 

chọn được thông số phù hợp. 

5. Xuất bản âm thanh 

Kích menu File -> Export -> Audio Mix Down 
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Chỉ định nơi lưu file, đặt tên ở ô File name, chọn kiểu file ở ô Save as type 

là mp3, bên mục Channels chọn Stereo, kích nút Save. 

 

BÀI THỰC HÀNH 

Bài 1. Thực hành ghi âm với nội dung ghi âm được cho ở tệp Noidung1.doc, 

sau đó tiến hành lọc nhiễu, rồi lưu lại với tên Ghiam1, sau đó xuất đoạn âm thanh 

với định dạng mp3 

Học viên có thể ghi âm với nội dung khác 

Bài 2. Thực hành ghi âm lời giảng với nhạc nền,  nội dung lời giảng cho 

trong tệp Noidung1.doc, nhạc nền được cho trong tệp Cam xuc tay nguyen.mp3 

(học viên có thể chuẩn bị nội dung ghi âm và nhạc nền riêng)  

Yêu cầu: Lọc nhiễu, cắt xén nhạc nền sao cho thời gian trùng khớp với thời 

gian của lời giảng, điều chỉnh âm thanh nhạc nền nhỏ hơn lời giảng (khoảng 20% 

so với lời giảng). Lưu với ghiam2.mp3 

Bài 3. Cho trước file âm thanh lời giảng (tệp lichsu.wma) và nhạc không lời 

(tệp Cam xuc tay nguyen.mp3), tiến hành biên tập thành 1 file âm thanh hoàn 

chỉnh (điều chỉnh, mix âm sao cho hài hòa giữa lời giảng và nhạc không lời). Xuất 

bản với tên Ghiam3.mp3 

Bài 4. Dùng điện thoại ghi âm với nội dung bất kỳ, chuyển file vào Audition, 

chỉnh sửa và xuất ra file mp3 
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Bài 4. SỬ DỤNG PHẦN MỀM XỬ LÝ VIDEO 

Thời gian: 18 giờ 

Mục tiêu 

 - Trình bày được các tính năng của phần mềm xử lý Video 

 - Sử dụng được các tính năng của phần mềm để biên tập Video từ hình ảnh, 

Video, âm thanh có sẵn thanh Video theo mong muốn; Xuất bản Video theo định 

dạng mong muốn. 

 - Rèn luyện tính cẩn thận, tỉ mỉ, sáng tạo. 

Nội dung 

1. Khởi động phần mềm 

Sau khi cài đặt xong nhấp vào biểu tượng Camtasia Studio 8 trên Desktop. 

Tiếp theo sẽ hiện ra bảng Welcome, có 2 khung chức năng chính: ghi màn 

hình, chèn âm nhạc, phim, ảnh. 

Hộp thoại này sẽ không xuất hiện lúc khởi động chương trình nếu nhấp chuột 

vào dòng chữ Show this dialog at startup. 

 

 

Sau khi khởi động xong, giao diện chương trình như sau: 
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2. Biên tập Video 

2.1. Xác định dữ liệu ban đầu cần biên tập video 

Trước khi biên tập, chúng ta phải nhập toàn bộ những tập tin cần thiết (hình 

ảnh, âm thanh, video) vào khung Clip Bin. 

Nhấp thẻ  Import media trên thanh menu, chọn tập tin (phim, âm thanh, hình 

ảnh) cần biên tập, nhấp Open. Tập tin xuất hiện trong khung Clip Bin, kéo tập tin 

và  

thả vào khe Video của khung Timeline. Bảng Editing Dimensions hiện ra hỏi 

xem có muốn chọn lựa kích thước khác không, sau đó nhấp OK. Nhấp nút Play 

trong của sổ Preview để xem, đồng thời ở bên dưới nút trượt (xanh đỏ) sẽ chạy 

trên vạch thời gian trình chiếu. 

Nếu là đoạn phim được ghi từ tập tin PowerPoint có chú thích (notes), khi 

kéo xuống khe Video bên dưới, sẽ xuất hiện hộp thoại hỏi xem có nhập những chú 

thích này không. Nếu nhấp Yes, những chú thích đó sẽ xuất hiện ở dưới phim 

(kiểu như phụ đề). 

Quay phim 

mà hình 

Import 

media 

Produce and share 
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2.2. Cắt ghép phim, nhạc, hình ảnh 

Ghép phim/ nhạc: Những đoạn phim, nhạc, hình ảnh cần thiết đã xuất hiện ở 

khe video, nếu cảm thấy không cần chỉnh sửa gì nửa thì có thể xuất phim (xem 

phần xuất phim). Phim khi xuất ra sẽ bao gồm nhiều đoạn phim, ảnh, âm thanh nối 

liền với nhau. 

Cắt phần đầu/ cuối phim/ nhạc: Kéo chuột đến đầu hoặc cuối đoạn phim/ 

nhạc, khi hiện ra mũi tên trắng thì kéo chuột sang phải hoặc sang trái, và thả chuột 

ra khi đã ưng ý. Sau đó có thể xuất phim/ nhạc nếu không cần chỉnh sửa gì nữa. 

 

Tách phim và nhạc: Thông thường phần Video và phần Audio của một 

đoạn phim nào đó luôn gắn chặt với nhau. Nếu muốn cắt phần đầu của Video 

nhưng giữ nguyên phần Audio thì phải vào nút Edit > Chọn Unlink Audio 1 

from Video 1 (hoặc nhấp vào điểm sáng ở Video 1 đầu khung Timeline) > Yes. 

Khung Clip Bin 
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Cắt phim/ nhạc thành nhiều đoạn: Kéo nút trượt đến vị trí cần cắt, nhấp 

vào nút Split (hoặc nhấn phím S, hoặc nhấp chuột phải, chọn Split).  

 

Ghép dữ liệu khác vào chỗ vừa cắt: Trước tiên, nhập phim/ nhạc, hình ảnh 

cần ghép vào Clip Bin, sau đó kéo dữ liệu xuống khe Video, vào đúng chỗ vừa cắt 

bỏ. Khi đã hài lòng, ta có thể xuất phim. 

Cắt bỏ hoặc sao chép đoạn giữa: 

Ví dụ cần cắt bỏ hoặc sao chép từ đoạn A đến B trong phim, kéo nút trượt 

đến vị trí A, sau đó tách nút trượt màu xanh lá cây và màu đỏ ra, kéo nút màu đỏ 

sang B. 

 

Vị trí vùng 

được chọn 

của Video 2 

 

Kích nút phải 

chuột 



58 

 

 

Nhấp chuột phải vào đoạn A->B, nếu cắt vỏ, chọn Cut (hoặc nhấn Ctr + X); 

nếu sao chép chọn Copy (hoặc nhấn Ctrl + C). 

Dán vào một vị trí khác trên Timeline bằng cách nhấp phải, chọn Paste (hoặc 

nhấp Ctrl + V). 

 Lưu ý: đoạn phim/ nhạc gốc vẫn không bị thay đổi. Nếu không biên tập gì 

nửa thì xuất phim. 

2.3. Tạo hiệu ứng chuyển cảnh 

- Click Transitions để tạo hiệu ứng chuyển cảnh. 
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- Chọn hiệu ứng, kéo thả vào đoạn video mình muốn. Nếu muốn thay đổi 

hiệu ứng khác thì click chuột phải tại hiệu ứng cần thay đổi và nhấp delete. Và 

chọn hiệu ứng rồi kéo thả vào chỗ cần thay đổi. 

- Điều chỉnh thời gian hiệu ứng: chọn hiệu ứng cần điều chỉnh, nhấp chuột 

phải, chọn Transition duration. 

- Có thể điều chỉnh thời gian như nhau cho các hiệu ứng bằng cách vào Tools 

> Options > Transitions. Bằng cách này cũng có thể điều chỉnh thời gian trình 

chiếu của hình ảnh, chú thích… 

 

- Xuất hiện hộp thoại: 
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2.4. Tạo trang giới thiệu 

Nhấp vào More, chọn Library, nhấp Title clips – Simple, sau đó chọn khung 

mong muốn. 

Nhập lời giới thiệu (tên phim, tác giả…) vào Text, sau đó chỉnh kiểu chữ, kích 

cỡ, màu chữ, dạng chữ, màu nền, hình nền…tùy ý. 

Có thể điều chỉnh thời gian của trang giới thiệu bằng 2 cách: đưa chuột đến 

cuối Title clip (ở khung Timeline) và kéo sang trái hoặc phải; hoặc nhấp chuột 

phải vào Title clips ở khung Timeline, sau đó chọn Title duration. 

Nếu muốn tạo trang giới thiệu ở giữa phim thì trước tiên phải tách đoạn phim 

ở vị trí cần chèn. 
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2.5. Tạo chú thích 

Khi muốn chú thích một vị trí nào đó trong phim và tạo nhiều hình thù đặc 

biệt cho chú thích, ta tạo callout như sau: 

+ Nhấp vào Callouts ở thành công cụ, nhấp Add callout. 

+ Nhấp chọn biểu tượng callout, chọn kiểu chữ, kích cỡ, màu chữ, màu 

khung viền, sau đó nhập nội dung vào. Có thể kéo chú thích đến vị trí tùy ý hoặc 

xoay theo bất kỳ hướng nào cũng được. 

+ Chú thích mới tạo sẽ xuất hiện ở khe Callout trong khung Timeline. 
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+ Điều chỉnh thời gian chú thích: đưa chuột đến cuối callout ở khe Callout 

trong khung Timeline và kéo sang trái hoặc phải; hoặc nhấp chuột phải vào 

callout ở khung Timeline, sau đó chọn Title duration. 

 

 

 

 

 

 

2.6. Viết ghi chú lên đoạn phim 

Nhấp vào More, chọn Captions. 

Trong khung thoại, nhập đoạn ghi chú cần hiển thị trên đoạn phim. Nếu quan 

sát ở cửa sổ Preview thấy đoạn chú thích hiển thị chưa được đẹp, nhấp chọn nút 

công cụ Overlay để đưa đoạn chú thích lồng hẳn vào biên dưới của phim, chứ 

không chừa khoảng đen phía biên dưới như mặc định. Thông số trong khung 

Width (in class) càng lớn thì kích thước của dòng chữ chú thích sẽ càng nhỏ. 

Khi hoàn tất, dòng chữ ghi chú cũng sẽ thể hiện ở khe Caption trong khung 

Timeline. 
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2.7. Thu âm cho phim 

Khi ghi hình bài giảng mà chưa thu lời giảng, hoặc muốn thuyết minh thêm 

thì ta có thể “lồng tiếng” cho phim. Lưu ý: kiểm tra xem microphone đã sẵn sàng 

cho việc thu âm chưa. Các thao tác thu âm như sau: 

+ Nhấp vào More, chọn Voice Narration, nhấp Start recording để bắt đầu 

ghi. 

 

 

+ Nhấp Stop recording để kết thúc. Khi đó sẽ hiện ra hộp thoại yêu cầu lưu 

đoạn âm thanh vừa thu. Khi đã lưu xong, đoạn âm thanh này sẽ xuất hiện ở khe 

Audio của khung Timeline. 

+ Biên tập âm thanh: Nhấp vào Audio ở thanh công cụ (hoặc đưa chuột vào 

đoạn âm thanh ở khe Audio, nhấp chuột phải, chọn Edit audio). Ở đây, ta có thể 

điều chỉnh âm lượng (Enable volume leveling, hoặc Colume down, Volume up), 
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chỉnh âm thanh tăng dần (Fade in), âm thanh nhỏ dần (Fade out), tắt âm thanh 

(Silence), thêm điểm mốc trên đường biên âm thanh để hiệu chỉnh âm thanh to 

nhỏ một cách chi tiết (Add audio point). 

 

Cách khác để tăng giảm âm lượng: nhấp vào Audio ở thanh công cụ, khi đó 

sẽ xuất hiện một đường ngang ở giữa đoạn âm thanh, đưa chuột đến đường ngang 

sẽ thấy mũi tên trắng theo chiều dọc, kéo mũi tên theo chiều lên hoặc xuống để 

tăng hoặc giảm âm lượng. 
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2.8. Cận ảnh thông minh 

Nếu quay một đoạn phim hướng dẫn sử dụng phần mềm có một vài chi tiết 

quá nhỏ không được rõ lắm, ta có thể phóng to những chi tiết quan trọng đó trên 

màn hình. Cách thực hiện như sau: 

+ Kích thẻ Zoom-n-Pan > Nhấp nút Open Zoom Option > Đánh dấu vào 

Apply Smart Focus To Clips Added > Ok. 

 

 

+ Tại khung bên trái, dùng chuột co dãn vùng chọn hình chữ nhật và kéo 

vào vị trí cần phóng to. Kết quả phóng to sẽ hiểnthị trên khung Preview. 
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+ Khi cần phóng to thu nhỏ một cảnh nào thì kéo nút trượt ở khung 

Timeline đến cảnh đó. 

+ Các cảnh áp dụng tính năng cận ảnh thông minh (Smart Focus) sẽ được 

nhận biết bằng ký hiệu ở khe Zoom trong khung Timeline. 

2.9. Hiệu ứng con trỏ chuột 

Ta có thể thay đổi kích thước và hiệu ứng nhấp chuột để đoạn phim trực 

quan hơn: 

+ Kích vào More > Cursor Effects > Mouse Cursor Visible để làm xuất 

hiện con trỏ trong đoạn phim. 

 

+ Chỉnh độ lớn con trỏ tại Cursor Size. 
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+ Mục Highlight Effect làm nổi bật những vùng có trỏ chuột đi đến như 

Spot Light, biến con trỏ thành đèn pin để chiếu sáng vùng chung quanh. 

+ Mục Left Click Effect / Right Click Effect cung cấp các hiệu ứng động 

khi nhấp chuột trái/ phải. 

+ Để chọn âm thanh cho mỗi lần nhấp chuột, ta nhấp Click Sound Effect 

và chọn âm thanh cho chuột trái, chuột phải. 

+ Hiệu ứng con trỏ chuột sẽ xuất hiện trong cửa sổ Preview, và được thể 

hiện ở khe Cursor trong khung Timeline. 

2.10. Tạo câu hỏi/ điều tra 

+ Kích vào More > Quizzing. Khi đó sẽ xuất hiện khe Quiz ở khung 

Timeline. 
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+ Kích vào Add Question nếu muốn tạo câu hỏi. 

+ Nhập nội dung câu hỏi vào khung Question. 

+ Nhập đáp án vào khung Answers. Nhấp vào Add nếu muốn tạo thêm câu 

đáp án. 

+ Nhấp vào ô vuông trước đáp án đúng. Khi đó sẽ hiện từ “Đúng” phía sau 

đáp án. 

+ Di chuyển thứ tự của các đáp án bằng cách nhấp Move up hoặc Move 

down. 

+ Nhấp vào Preview để xem thử. 

Lưu ý: Khi xuất phim, phải chọn lưu Web, hoặc định dạng là SWF mới 

xem được phần câu hỏi/ điều tra.  

3. Lưu, mở file Video 

3.1. Lưu file Video 

Nên lưu lại đoạn phim đang biên tập để khi khác tiếp tục chỉnh sửa 
bằng cách nhấn ctrl+s hoặc vào FileSave project. Đoạn phim được lưu 
có định dạng Camrec.  

  
 
 

3.2. Mở file Video 

Mở Video gốc đã lưu khi biên tập để tiếp tục chỉnh sửa bằng cách nhấn 

ctrl+O hoặc vào FileOpen project. 

4. Ghép âm thanh vào Video 

Đối với những đoạn phim có chất lượng âm thanh không tốt hoặc âm thanh 
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trong phim không phù hợp, ta muốn thay thế đoạn âm thanh đó bằng 1 đoạn âm 

thanh khác; hoặc muốn chèn nhạc nền vào video, thực hiện: 

Import file âm thanh vào khung Clip Bin, sau đó kéo thả xuống vùng video. 

Trong 1 video chúng ta có thể ghép nhiều hơn 1 file âm thanh, khi đó các file âm 

thanh sẽ được bố trí trên nhiều Track Audio khác nhau. 

Sau đó điều chỉnh âm lượng của các audio cho phù hợp và có thể cắt xén, 

biên tập lại. 

 

5. Xuất bản Video 

Khi đã hoàn tất quá trình thu bài giảng và biên tập phim/nhạc, ta có thể 

xuất ra đoạn phim/nhạc với các định dạng như: SWF, FLV, AVI, MP4, WMV, 

MOV, RM, GIF động và EXE. Ngoài ra, ta cũng có thể xuất ra để ghi vào CD 

hay đưa lên Web. 

Thông thường, ta nên xuất phim lưu trong máy: 

Nhấp vào Produce and share ở thanh menu, xuất hiện hộp thoại 

production Wizard, chọn chế độ cần xuất, click Next.  

 
 

- Xuất hiện hộp thoại:  
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Thông thường đối với đoạn phim, nên chọn định dạng WMV vì dung 

lượng không quá lớn, cũng không quá nhỏ, dễ tích hợp với các chương trình 

khác, hoặc định dạng  FLV có dung lượng rất nhỏ, đối với đoạn âm thanh, chỉ 
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có một định dạng MP3. Nếu đoạn phim được sử dụng để chèn vào phần mềm 

e-learning Presenter thì chọn định dạng MP4 Sau đó cứ nhấp Next. 

Khi xuất hiện Output file thì điền tên đoạn phim/nhạc, chọn đường dẫn 

để lưu. Cuối cùng, nhấp Finish. 

Xuất âm thanh của đoạn phim: nếu chỉ cần phần âm thanh mà không cần 

phần hình của đoạn phim, vào File produce specialExport audio 

aschọn đường dẫn để lưu và đặt tên tập tin âm thanh (chọn định dạng mp3 

hoặc wav).  

 
 
 
 
 

Xuất ảnh của đoạn phim: nếu muốn lưu lại một cảnh nào đó của đoạn 

phim thành tập tin hình ảnh riêng, ta vào FileProduce specialExport 

frame asChọn đường dẫn để lưu và đặt tên tập tin hình ảnh (chọn định dạng 

jpeg hoặc 

png). 
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BÀI TẬP THỰC HÀNH 

 

Bài 1. Tạo một video gồm ít nhất 10 ảnh liên quan đến chủ đề nào đó (gợi 

ý: danh lam thắng cảnh, món ăn, động vật, thực vật, giao thông,…)  và có nhạc 

nền 

Yêu cầu: 

- Hình ảnh và nhạc nền cho HV tìm kiếm trên mạng để đưa vào video 

- Chèn tiêu đề, chú thích vào clip  

- Tạo hiệu ứng chuyển tiếp giữa 2 ảnh 

- Định thời gian chuyển ảnh, tức là thời gian để chạy hiệu ứng (Transition). 

- Lưu project 

- Xuất Video với định dạng mp4 (tên Phim1.mp4) 

Bài 2. Cho trước các hình ảnh và file âm thanh trong thư mục Du lieu BT 

Phim, thực hiện biên tập video từ hình ảnh và âm thanh đã cho, xuất bản ra định 

dạng mp4 (Phim2.mp4) 
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Yêu cầu: nghe âm thanh và sắp xếp các hình ảnh sao cho phù hợp, điều 

chỉnh thời gian trên ảnh sao cho trùng khớp với âm thanh đang nghe, chèn hiệu 

ứng chuyển cảnh phù hợp,… 

Bài 3. Cho trước file video và file nhạc nền ở thư mục Du lieu BT Phim 

(file video P1.mp4, file nhạc nền Cam xuc tay nguyen.mp3), thực hiện lồng nhạc 

nền vào video và xuất bản với định dạng mp4 (Phim3.mp4 ) 

Bài  4. Cho trước hình ảnh, file âm thanh, đoạn video ở thư mục Du lieu 

BT Phim, thực hiện biên tập thành video (Phim4.mp4) 

Bài 5. Tạo video với thời gian không quá 5 phút với nội dung do học viên 

tự chọn, xuất bản với định dạng mp4 (Phim5.mp4) 
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Bài 5. XÂY DỰNG BÀI GIẢNG E_LEARNING 

Thời gian: 50 giờ 

Mục tiêu: 

 - Trình bày các tính năng của Adobe Presenter. 

 - Sử dụng các tính năng của Adobe Presenter để biên tập bài giảng trên 

PowerPoint thành bài giảng e-Learning như thiết lập thông tin bài giảng, giáo 

viên; chèn âm âm thanh, lời giảng, video, thiết lập bài tập trắc nghiệm và đưa 

các câu hỏi trắc nghiệm vào bài giảng. 

 - Xuất bản bài giảng theo chuẩn e-Learning và theo định dạng khác. 

 - Rèn luyện tính cẩn thận, tính chính xác. 

Nội dung: 

1. Tạo nội dung bài giảng trên PowerPoint 

Để xây dựng bài giảng e-learning trên Adobe Presenter, trước tiên chúng ta 

tạo nội dung bài giảng trên Power Point, bài giảng phải đảm bảo theo nguyên tắc 

đã trình bày ở bài 1. 

2. Thiết lập thông tin ban đầu cho bài giảng 

2.1. Thiết lập thông tin bài giảng 

 - Chọn menu ADOBE PRESENTER trên PowerPoint -> Chọn Settings  

 

 

 

 

Xuất hiện cửa sổ dưới đây để thiết lập các tham số cho bài giảng 

Chọn mục này để 

thiết lập bài giảng 
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Appearance: Thiết lập tiêu đề và 

tóm tắt bài giảng 

+ Title: Tiêu đề bài giảng 

+ Summary: Tóm tắt bài giảng 

 

 

Playback: Thiết lập các thông số 

trình chiếu bài giảng 

+ Auto play on start: Tự động 

chạy bài giảng 

+ Loop precention: Lặp lại bài 

trình chiếu khi hết slide 

+ Include slide number in 

outline: Hiển thị cả số thứ tự slide 

 + Pause after each animation: 

Dừng sau mỗi hiệu ứng slide 

+ Use PPTX Slide Time: Sử 

dụng thời gian trên PowerPoint 

+ Always show focus retangle: 

Hiển thị các tiêu điểm khung hình 

vuông 

+ 5.0: Tự động chuyển slide sau 

xx giây nếu không có âm thanh và 

video 
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Quality: Thiết lập các chất lượng 

trình chiếu, Cửa sổ này dùng để 

thiết lập chất lượng âm thanh, hình 

ảnh và video 

 

 

Attachments: Đính kèm các tập tin 

khác 

 

Add: Chọn tập tin đính kèm và bấm 

OK để chèn các tập tin cần đính 

kèm 

 

 

2.2. Chọn giao diện theme có sẵn 

 Adobe Presenter  Theme  Chọn mẫu  OK 

2.3. Tự thiết kế giao diện theme 

 Adobe Presenter  Theme 

   Appearance: 

Theme: Màu tổng thể 

Glow: Màu vị trí con trỏ chuột 

Font: Màu chữ 

Backgroand: Màu nền 

  Background Image: Chọn ảnh có sẵn làm nền 

  Notes Pane Font: Chọn font chữ cho cửa sổ ghi chú 
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 Size: Chọn kích thước chữ 

2.4. Việt hóa giao diện 

Adobe Presenter  Theme  Modify Text Labels…  Nhấp đôi chuột vào 

dòng Custom Text  Nhập nội dung tiếng Việt  OK 
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3. Thiết lập thông tin ban đầu của giáo viên 

Adobe Presenter  Setting  Application  Presenters  Add 

 Name: Gõ tên 

 Job Title: Nghề nghiệp 

 Photo: Hình 

 Logo: Hình của đơn vị 

 Email: Địa chỉ mail 

 Biograply: Giới thiệu vắn tắt về tác giả 

 OK 

 

4. Ghi âm lời giảng 

Adobe Presenter  Record (tại mục Audio)  Adobe sẽ kiểm tra 

Micro (chờ màu đỏ chuyển sang màu xanh lá)  OK  có thể dùng các nút 

lệnh qua lại để chọn Slide cần ghi âm  Chọn  để bắt đầu ghi âm   Chọn 

 khi ghi âm hoàn tất  Chọn  để nghe lại  Chọn Save để lưu file 



 

80 

 

âm thanh  chọn Close để đóng. Hoặc chọn Discard để hủy bỏ âm thanh vừa 

ghi âm. 

5. Chèn âm thanh vào bài giảng 

Adobe Presenter  Import (tại mục Audio)  Chọn Slide cần đưa âm 

thanh vào -> nhấp Browse để chọn file âm thanh cần chèn  OK  OK  

6. Đồng bộ âm thanh với nội dung bài giảng 

Với nội dung bài giảng đã được tạo và đã thiết lập tạo hiệu ứng, sau khi 

chèn âm thanh (lời giảng) vào slide, cần tiến hành đồng bộ âm thanh khớp với 

từng nội dung trên Slide, ta tiến hành như sau: 

Chọn Slide cần đồng bộ -> Adobe Presenter -> Sync 

 
 

Kích vào biểu tượng  để bắt đầu đồng bộ âm thanh với hiệu ứng 

 

Màn hình tiếp theo xuất hiện, kích nút  để chuyển qua hiệu ứng tiếp 

theo cho đến hết 

 
Sau đó chọn Save để lưu lại, hoặc Discard để hủy 

 

7. Biên tập âm thanh trong slide 

Chọn Slide cần biên tập lại âm thanh -> Adobe Presenter -> Edit 
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xuất hiện hộp thoại cho phép chỉnh sửa âm thanh: 

- Xóa âm thanh: chọn đoạn âm thanh muốn xóa trong vùng sóng âm và 

bấm phím Delete 

- Sao chép: chọn đoạn âm thanh muốn sao chép trong vùng sóng âm -> 

Ctrl+C -> đặt con trỏ ở vị trí muốn chép đến -> Ctrl+V 

 

 

- Ghi âm bổ sung: Đặt con trỏ ở vị trí muốn ghi âm -> kích vào nút Record 

màu đỏ, nghe lại kích vào nút Play 

8. Ghi hình trực tiếp 

Adobe Presenter -> Record 

 
 

9. Chèn Video vào bài giảng 

Adobe Presenter  Video  Import  Chọn file video cần chèn  OK 

10. Biên tập Video 

Adobe Presenter  Video  Edit  

Record 

Play 
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Giới hạn thời gian trình chiếu:  

Nhấn giữ hai nút tam giác và kéo đến vị trí cần giới hạn 

 Tại ô Effects 

  Fade in: Video bắt đầu mờ, từ từ rõ dần lên 

  Fade Out: Video đang rõ, từ từ mờ dần đi 

 Tại ô Start After 

  Time Delay: Video sẽ bắt dầu trình chiếu sau một khoảng thời gian 

quy định trước ở ô Time (thời gian tính bằng giây) 

  Animations: Video sẽ bắt dầu trình chiếu sau khi tất cả các hiệu 

ứng trên Slide Powerpoint đã hoàn tất. 

  Presenter Audio: Video sẽ bắt dầu trình chiếu sau khi kết thúc lời 

ghi âm của giáo viên. 

  OK  

11. Chèn câu hỏi trắc nghiệm vào bài giảng 

Trong một bài giảng, có thể tạo nhiều bộ câu hỏi khác nhau với mục đích 

khác nhau, một bộ câu hỏi gọi là một Quiz, trong một bộ câu hỏi có nhiều câu 

hỏi, mỗi câu hỏi gọi là Question, câu hỏi có nhiều loại: câu hỏi nhiều lựa chọn, 

đúng/sai, ghép đôi, điền khuyết,… 

Ví dụ: một bài giảng, GV có thể tạo 3 bộ câu hỏi (3 Quiz): Quiz 1 có 3 câu 

hỏi để kiểm tra bài cũ, Quiz 2 có 5 câu hỏi nhằm khai thác nội dung bài học, 

Quiz 3 có 10 câu hỏi để củng cố bài học 

Để tạo và quản lý câu hỏi trắc nghiệm, vào menu ADOBE PRESENTER, 

trong ngăn Quiz, chọn Manage. Để thêm bộ câu hỏi, chọn nút Add Quiz,  để 

thêm câu hỏi, chọn Add Question, có các loại câu hỏi sau: 
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- Câu hỏi lựa chọn 

- Câu hỏi đúng/sai 

- Điền vào chỗ khuyết 

- Trả lời ngắn với ý kiến của 

mình.  

- Ghép đôi 

- Đánh giá mức độ.  

- Không có câu trả lời đúng 

hay sai. 

- Sắp xếp thứ tự 

- Xác định vị trí đúng 

- Kéo thả 
 

 

11.1. Dạng Multiple choice: Trắc nghiệm nhiều lựa chọn 

Manage  Chọn thẻ Quiz  Chọn Add Question  Multiple choice  

Create Graded Question 

 Name: Nhập tên câu hỏi (Thể loại câu hỏi) 

 Question: Nhập câu hỏi 

 Score: Nhập điểm số cho câu hỏi 

Chọn Add: Nhập các câu trả lời  Đánh dấu  vào câu trả lời đúng nhất 

 Đánh dấu nếu muốn đảo lộn các câu trả lời 

Tại mục Type chọn: 

 Multiple Responses: Câu hỏi có nhiều đáp án đúng 

 Single Response: Chỉ có một đáp án đúng duy nhất 

OK 

11.2. Dạng True/ Fale: Câu hỏi đúng/sai  
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Manage  Chọn thẻ Quiz  Chọn Add Question  True/ Fale  

Create Graded Question 

- Name: Nhập tên câu hỏi (Thể loại câu hỏi) 

- Question: Nhập câu hỏi 

- Score: Nhập điểm số cho câu hỏi 

 Nhập câu trả lời cho hai mục Đúng(True) và Sai(False)  Đánh 

dấu  vào câu trả lời đúng 

- Tại mục Type chọn: 

 True/ False: Câu hỏi đúng/ sai 

 Yes/ No: Câu hỏi có/ không 

 OK 

11.3. Dạng điền khuyết  

a. Người học tự nhập nội dung 

Manage  Chọn thẻ Quiz  Chọn Add Question  Fill-in-the-black   

Create Graded Question 

- Name: Nhập tên câu hỏi (Thể loại câu hỏi) 

- Description: Nhập lời hướng dẫn 

- Score: Nhập điểm số cho câu hỏi 

- Phrase: Nhập câu hỏi cần điền vào chỗ trống, để tạo chỗ trống Add 

Black  Tích chọn ô The user will type in the answer, which will be 

compared to the list bolow  Add  Nhập đáp án đúng mà học sinh cần điền 

OK  Tiếp tục nhập phần còn lại của ô Phrase, có thể tạo thêm các trắng 

khác (Tối đa 8 khoảng trắng)  OK  OK 

b. Người học chọn nội dung  

Manage  Chọn thẻ Quiz  Chọn Add Question  Fill-in-the-black   

Create Graded Question 

- Name: Nhập tên câu hỏi (Thể loại câu hỏi) 

- Description: Nhập lời hướng dẫn 

- Score: Nhập điểm số cho câu hỏi 
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- Phrase: Nhập câu hỏi cần điền vào chỗ trống, để tạo chỗ trống Add 

Black  Tích chọn ô The user will selete an answer from the list below  

Add  Nhập tất cả các đáp án để tạo danh sách lựa chọn  Đánh dấu vào đáp 

án đúng  OK Tiếp tục nhập phần còn lại của ô Phrase, có thể tạo thêm các 

trắng khác (Tối đa 8 khoảng trắng)  OK  OK 

11.4.  Dạng trả lời ngắn  

Manage  Chọn thẻ Quiz  Chọn Add Question  Short answer   

Create Graded Question 

- Name: Nhập tên câu hỏi  

- Question: Nhập câu hỏi 

- Score: Nhập điểm số cho câu hỏi 

 Add  Nhập các câu trả lời để kiểm tra  OK  OK 

11.5. Dạng nối cặp 

Manage  Chọn thẻ Quiz  Chọn Add Question  Matching   

Create Graded Question 

Name: Nhập tên câu hỏi  

Question: Nhập câu hỏi 

Score: Nhập điểm số cho câu hỏi 

 Nhập tên của 2 cột  Nhập nội dung của 2 cột  Chọn nội dung 

từ cột thứ nhất, sau đó kéo sang cột thứ hai tại đáp án phù hợp  OK  OK 

11.6. Dạng sắp xếp 

 a. Người học tự kéo/ thả  

Manage  Chọn thẻ Quiz  Chọn Add Question  Sequence   

Create Graded Question 

Name: Nhập tên câu hỏi  

Question: Nhập câu hỏi 

Score: Nhập điểm số cho câu hỏi 

 Add  Lần lượt nhập các đối tượng cần sắp xếp theo đúng thứ tự 

đáp án. 

Có thể dùng: Nút Delete: Xóa một nội dung 
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  Move up: Di chuyển nội dung đang chọn lên trên 

  Move down: Di chuyển nội dung đang chọn xuống dưới. 

 OK  OK 

b. Người học chọn từ danh sách  

Manage  Chọn thẻ Quiz  Chọn Add Question  Sequence  Create 

Graded Question 

- Name: Nhập tên câu hỏi (Thể loại câu hỏi) 

- Question: Nhập lời hướng dẫn 

- Score: Nhập điểm số cho câu hỏi 

 Add  Lần lượt nhập các đối tượng cần sắp xếp theo đúng thứ tự 

đáp án. 

- Style: chọn Drop Down list 

Có thể dùng: Nút Delete: Xóa một nội dung 

  Move up: Di chuyển nội dung đang chọn lên trên 

  Move down: Di chuyển nội dung đang chọn xuống dưới. 

 OK  OK 

11.7. Tạo câu hỏi định vị  

Manage  Chọn thẻ Quiz  Chọn Add Question  Hot spot   Create 

Graded Question 

- Name: Nhập tên câu hỏi (Thể loại câu hỏi) 

- Question: Nhập lời hướng dẫn 

- Score: Nhập điểm số cho câu hỏi 

- Hot Spots: Chọn số điểm cần định vị 

- Choose: Chọn hình ảnh cho con trỏ chuột 

 OK  OK 

Trở lại slide Powerpoint, chọn điểm Hot spost thứ nhất  click vào biểu 

tượng  nhấn giữ và kéo biểu tượng này vào trung tâm hình vuông  Click 

phải vào điểm Hot spot, sau đó chọn màu đường viền là No Outline (Thao tác 
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này nhằm giấu đi đường viền chung quanh điểm Hot spot, để người học không 

biết trước đáp án của câu hỏi) 

Thực hiện tương tự với các điểm Hot spot khác 

Chèn hình ảnh/ sơ đồ vào slide Powerpoint thông qua thao tác Insert/ 

Picture 

Click phải vào hình ảnh/ sơ đồ, sau đó chọn Send to black/ Send to black 

Lần lượt kéo các điểm Hot spot vào đúng đáp án 

11.8. Tạo câu hỏi kéo thả  

Manage  Chọn thẻ Quiz  Chọn Add Question  Drag drop   

Create Graded Question 

- Name: Nhập tên câu hỏi (Thể loại câu hỏi) 

- Score: Nhập điểm số cho câu hỏi 

- Chon nút lệnh   để chọn một hình ảnh làm phông nền cho câu 

hỏi 

Cột Drag Item: Chọn nút lệnh Add image Drag  để chọn một hình 

làm đối tượng sẽ được kéo thả hoặc Chọn nút lệnh Add Text Drag để nhập 

đoạn văn bản ngắn để làm đối tượng sẽ được kéo thả 

Cột Drop Target:  Chọn nút lệnh Add image Drop  để chọn một 

hình làm vị trí được thả vào hoặc Chọn nút lệnh Add Text Drop để nhập đoạn 

văn bản ngắn để làm đối tượng sẽ được gắn vào 

 Hoặc chọn nút lệnh Blank Drop  để tạo một vị trí trống tương 

ướng với hình sẽ được thả vào 

 Chọn   Thay đổi kích thước hoặc bố trí lại vị trí 

của các đối tượng có trong câu hỏi  

 OK  OK 
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12. Chỉnh sửa, xóa một câu hỏi  

12.1. Chỉnh sửa một câu hỏi 

Manage  Thẻ Quizzes  Chọn câu hỏi cần chỉnh sửa  Edit Thẻ 

Question  Chỉnh sửa  OK  OK 

12.2. Xóa một câu hỏi 

Manage  Thẻ Quizzes  Chọn câu hỏi cần xóa Chọn Delete  OK 

 OK 

12.3. Cho phép người học trả lời một câu hỏi nhiều lần 

Manage  Thẻ Quizzes  Chọn câu hỏi cần chỉnh sửa  Edit  Thẻ 

Option  

If correct answer ( Khi người học trả lời đúng) 

 Action: Go to next Slide: Đi đến Slide kế tiếp 

  Go to Slide: Đi đến một Slide cụ thể 

  Open Url: Mở một địa chỉ Web 

 Play audio clip: Thu âm lời khen vào âm thanh khen ngợi 

 Show correct message: Đánh dấu chọn để hiện thông điệp cho biết 

người học đã làm đúng 

If wrong answer ( Khi người học trả lời sai) 

 Allow user: Chọn số lần người học được phép trả lời câu hỏi 

 Hoặc đánh dấu chọn ô Infinite attempts để cho phép thực hiện lại 

câu hỏi không giới hạn số lần. 

 Action: Go to next Slide: Đi đến Slide kế tiếp 

  Go to Slide: Đi đến một Slide cụ thể 

  Open Url: Mở một địa chỉ Web 

 Play audio clip: Thu âm lời nhắc nhở 

 Đánh dấu chọn : 

  Show error message: HIện thông điệp cho biết người học đã 

trả lời sai. 

  Show retry message: Nhắc người học trả lời lại 
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  Show in complete message: Hiển thị thông báo về việc chưa 

hoàn thành câu hỏi. 

OK 

13. Thiết lập cho câu hỏi trắc nghiệm 

13.1. Quản lý bộ câu hỏi 

 Adobe Presenter  Manage 

Thẻ Quizz: Quản lý các câu hỏi có trong bài giảng 

+ Add Quizz: Thêm bộ câu hỏi. 

 Thẻ Output Option: Quy định một số nội dung về bộ câu hỏi 

 

 

Hiển thị danh sách câu hỏi tại phần outline 

Hiển thị điểm của mỗi câu hỏi 

Hiển thị số lần được trả lời câu hỏi 

Hiển thị số điểm đang có 

Hiển thị điểm cần đạt và điểm tối đa 

Hiển thị số lần trả lời bộ câu hỏi 

 

Hiển thị nhắc nhở khi chưa hoàn thành bộ 

câu hỏi 

 

Thẻ Default Labels: Quản lý các nhãn cho câu hỏi 

+ Submit button labels: Tên nút lệnh Submit (Chọn, Nộp bài) 

+ Clear button text: Tên nút lệnh Clear (Xóa, Làm lại) 

+ Correct message: Thông điệp khi người học trả lời đúng (Đáp án đúng – 

Click để tiếp tục) 

+ Incorrect message: Thông điệp khi người học trả lời sai (Đáp án sai – Click 

để tiếp tục) 

+ Retry message: Thông điệp nhắc người học làm lại (Thử làm lại) 
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+ Incomplete message: Thông điệp nhắc người chưa trả lời câu hỏi (Cần phải 

hoàn thành câu hỏi) 

  Thẻ Appearane: Thiết lập kiểu chữ, cỡ chữ … mặc định (Trang 18) 

  + Mục Current Profile: Những thiết lập hiện hành. Sau khi thiết lập 

kiểu chữ, ta có thể Save As, để sử dụng lâu dài. 

  + Question: Font chữ cho các câu hỏi 

  + Answer: Font chữ các câu trả lời 

  + Button: Font chữ cho các nút bấm 

  + Message: Font chữ cho các thông báo 

  + Mục Button placement: Thiết lập vị trí mặc định cho các nút bấm. 

  Vertical: Nút bấm nằm dọc 

Horizontal: Nút bấm nằm ngang 

  Position on slide: Vị trí trên slide 

  Bottom right: Dưới – phải 

  Bottom left: Dưới – trái 

  Bottom Center: Dưới – giữa 

  Center Right: Giữa – phải 

  Apply formatting to all existing quizzess: Áp dụng thiết lập cho tất 

cả câu hỏi đã có sẵn. 

13.2. Thiết lập thuộc tính của một bộ Quiz:  

Manage  Chọn bộ Quiz  Edit  Chọn thẻ Quiz Settings  

 Quiz 

Name: Nhập tên của bộ câu hỏi (Ví dụ: Câu hỏi kiểm tra bài cũ) 

  Required: Chọn tùy chọn thích hợp 

   Người học có thể bỏ qua câu hỏi 

 Người học cần thực hiện bài kiểm tra 

 Người học cần hoàn thành bài kiểm 

tra 

 Người học cần trả lời 

đúng tất cả các câu hỏi trong bài kiểm tra 
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Settings 

 

Cho phép quay lại câu hỏi trước 

Cho phép xem lại các câu hỏi đã trả lời 

Cho phép xem các slide hướng dẫn 

Hiện kết quả kiểm tra khi hoàn tất 

Hiện bảng câu hỏi tại mục lục 

Hoán đổi trật tự câu hỏi 

Hoán đổi trật tự câu trả lời 

 OK 

13.3. Việt hóa giao diện câu hỏi:  

Manage  Chọn bộ Quiz  Edit  Chọn thẻ Quiz Settings  

   

  Correct: Thông điệp khi người học trả lời đúng ( Bạn đã hoàn 

thành) 

  Incomplete: Thông điệp khi người học chưa hoàn thành bài kiểm 

tra (Bạn chưa hoàn thành) 

  Incorrect: Thông điệp khi người học trả lời sai (Câu trả lời của bạn: 

Đáp án đúng là:) 

   OK 

   

  Pass message: Thông điệp khi người học vượt qua bài kiểm tra 

  Fail message: Thông điệp khi người học không vượt qua được bài 

kiểm tra 

         Đánh dấu chọn vào ô trống tùy theo nhu cầu 
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Hiển thị kết quả kiểm tra 

Hiển thị tỉ lệ phần trăm kết quả kiểm tra 

Hiển thị tỉ lệ các câu trả lời đúng 

  OK 

13. 4. Thiết lập yêu cầu cho bài kiểm tra:  

Manage  Chọn bộ Quiz  Edit  Pass or Fail Options 

   Qui định tỉ lệ các câu trả lời 

đúng cần đạt để được công nhận hoàn thành bài kiểm tra. Hoặc nhập số điểm 

cần đạt để hoàn thành bài kiểm tra. 

  Nếu hoàn thành 

bài kiểm tra 

  Go to next Slide: Đi đến slide kế tiếp 

  Go to Slide: Đi đến 1 Slide cụ thể 

  Open Url: Mở một địa chỉ Web 

   

Nếu không hoàn thành bài k/tra 

  Go to next Slide: Đi đến slide kế tiếp 

  Go to Slide: Đi đến 1 Slide cụ thể 

  Open Url: Mở một địa chỉ Web 

 OK 
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14. Xuất bản bài giảng 

 Xuất bài giảng sang chuẩn SCORM 

Chọn Adobe Presenter, nút Publish. 

Khi này một bảng sau hiện ra cho các chọn lựa:  

 

- My Computer: Lưu trên máy tính  

- Location: đường dẫn đến thư mục chứa kết quả xuất bản. Nếu để mặc 

định thì thư mục sẽ là  

Publish Format: Đánh dấu chọn vào các tùy chọn sau: 

 SWF: Xuất bản file flash, bài giảng mở trên các trình duyệt web có hỗ trợ 

Flash Player 

 HTML5: Xuất bản dạng địa chỉ Web, hỗ trợ mở bài giảng trên các thiết bị 

cầm tay như mobile, ipad,… 

 Both: Xuất bản cả file flash và dạng địa chỉ Web 

Output Option: 

 Zip package: nếu muốn xuất thành phẩm dạng gói file nén chuẩn 

SCROM 

 CD package: nếu muốn tạo đĩa CD có sẵn tiện ích tự động chạy. 

Đánh dấu chọn: View output after publishing nếu muốn xem sản phẩm khi đã 

xuất bản xong. 

  Publish: để bắt đầu tiến hành xuất bản sản phẩm. 
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 Sau khi Adobe xuất bản xong thành phẩm, trang web sẽ tự động khởi 

chạy. 

 

BÀI THỰC HÀNH 

Bài 1: 

1. Tạo file bài giảng trên Power Point với các Slide sau: 

Slile 1: 

 

Slide 2 

 

Slide 3 
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- Tạo hiệu ứng cho các nội dung trên slide 

2. Biên tập với yêu cầu sau: 

- Chèn nhạc nền cho Slide 1, cắt bớt nhạc nền chỉ để lại 25s (nhạc nền do 

học viên tự chọn), đồng bộ nhạc nền với hiệu ứng chữ để chữ lần lượt xuất hiện. 

- Ghi âm trực tiếp tương ứng với nội dung của Slide 2  

- Chèn âm thanh đã ghi vào Slide 3 và đồng bộ âm thanh và hiệu ứng chữ 

cho khớp (file Ghiam2.mp3 đã được thực hiện ở bài thực hành bài âm thanh). 

- Chèn video đã biên tập ở bài “Biên tập phim” (Phim3.mp4) vào Slide tiếp 

theo của bài giảng. 

- Chèn các câu hỏi trắc nghiệm sau: 

đáp án C 
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đáp án B 

đáp án Ngọc Linh, Kon Tum 

 

Đáp án: 1- D; 2-A; 3- B; 4-F; 5-C  

- Thực hiện thiết lập thông tin ban đầu cho bài giảng và thông tin giáo viên 

(là thông tin của học viên). 

3. Xuất bản bài giảng với chuẩn HTML5 

Bài 2:  Xây dựng 1 bài giảng e-learning về 1 chủ đề môn học do HV tự 

chọn hoặc giới thiệu 1 sản vật hoặc 1 danh lam thắng cảnh, món ăn tại địa 

phương. 
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